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Welcome
Welcome to Encoder Pro, Medicode’s powerful coding and reference software. Encoder Pro

offers a fast, easy way to find ICD-9, CPT, and HCPCS codes. Packed with information from

Medicode’s publications, this application helps you confidently select the proper codes for your

needs. This online User’s Manual explains Encoder Pro’s features, and guides you through the

program’s basic functionality. You’ll learn how to:

• Install Medicode’s Encoder Pro software

• Perform a code search

• View the Index of the CPT, HCPCS, and ICD-9 books

• Use the narrow search feature

• Use the E/M Encoder

• View code-specific information

• View Deleted Codes

• View CPT codes that have been assigned color coding

• View ICD-9 codes that have been assigned color coding

• View HCPCS codes that have been assigned color coding

• Enter information into the electronic HCFA-1500 form

• Create and use sticky notes and bookmarks

• Copy text to the Windows™ clipboard using the Notepad

• Print code information

Getting Help
• Consult this User’s Manual.

• Click the Help button in any dialog box to view related online help topics.

• Access the online help by selecting an item from the Help menu or clicking the Help [?]

icon. Online help includes information about how to use the application and provides

information about coding.

• Call 800-765-6797 to speak with a Medicode software technical support representative.

Troubleshooting
• If you receive a msvcrt.dll error message at startup, you need to run the dll update

install which is under the Update directory on your installation CD.

• If you enter a search term and the CPT code set checkbox is unavailable (grayed out),

you must edit your epro.ini file located in the Windows directory as follows:

− If the “CUSTOM” setting under the [SEARCH] category states CUSTOM=14 or less,

change the number to read 15.

− If the CUSTOM setting does not exist, you must add a line that states CUSTOM=15.
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Software Features
Easy Code Search

Medicode’s Encoder Pro is uncomplicated and easy to use. Search results and code information

display on one screen.

Includes all Code Sets

You can search for ICD-9, CPT, and HCPCS codes. Your search results can be limited to just

one code set, a combination of two, or all three.

Entering Search Terms

You can enter up to four search terms to allow you to narrow down the results when you first

initiate a search. A spell check feature ensures that you enter valid terms.

Search Type

You can set the search preferences to limit your searches to certain code sets (e.g., just ICD-9

Vol. 1 and CPT) and define the parameters of your search results.

Sorting Search Results

The search results show all codes that match your search criteria. You can sort results with the

most likely codes listed first (by rank), or in alphanumeric order. The number of code matches

found is referenced on screen.

Narrowing Search Results

You can narrow the search results by clicking the Narrow button. Narrow Search features let you

specify the type of code (e.g., surgery, radiology, hospital procedure, etc.) and/or select additional

terms that further identify the anatomy, diagnosis, treatment, supply, or other criteria specific to

your search. You can use the Narrow Search as often as necessary to pare down the results to

specific codes.

Viewing Search Results

Fourth- and fifth-digit ICD-9 codes are grouped as sublevels under each primary code. CPT and

HCPCS codes are grouped as sublevels under the corresponding subsection, identified by the

range of codes in that subsection.

Index Results

You can see codes similar to the way they are displayed in the index of the ICD-9, CPT, and

HCPCS books. The Index Results window displays codes and their descriptions for the current

search.
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Tabular Listing

Select any code listed in the Tabular Results to view the full description for the code and all

neighboring codes in the adjacent Tabular Listing. For ICD-9 codes, the Tabular Listing also

shows excludes and includes notes, as well as “code first” and “code also” references. CPT and

HCPCS codes in the Tabular Listing are grouped by section/subsection.

Code-Specific Dialog Boxes for ICD-9

You can easily view tabular section notes, AHA Coding Clinic references, annotations, CPT

crosscodes, and DRG crosscode for the selected ICD-9 code.

Code-Specific Dialog Boxes for CPT

You can easily view lay descriptions, CPT Assistant references, AMA guidelines, primary

procedure codes, modifiers, surgical and anesthesia crosscodes, Medicare information, and

component and mutually exclusive unbundles from Medicare’s Correct Coding Initiative for the

selected CPT code.

Code-Specific Dialog Boxes for HCPCS

You can easily view annotations, section notes, modifiers, and coverage instruction references

from the Medicare Carrier’s Manual and the Coverage Issues Manual for the selected HCPCS

code.

HCFA-1500 Electronic Form

With the HCFA-1500 feature you can create and print an electronic version of the form for each

patient.

The History Menu

The History menu lists a trail of previously viewed codes. This makes it easy to go back to a

previous code selection for the current session.

Bookmarks

With Bookmarks you can store a list of frequently used codes.

Copying Codes

You can copy codes, descriptions, and modifiers into the Windows clipboard to be pasted into

other Windows applications. The Notepad lets you send multiple codes to the clipboard at one

time. Using the Preferences dialog box, you can decide if you’d like to copy the code only, or the

code and its description.

Deleted Codes

Encoder Pro alerts you when you’ve entered a deleted code as search criteria. The Deleted Codes

dialog box appears whenever you enter a deleted code or when you access it through the View

menu. This dialog box lists all the deleted codes for each applicable code set.
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Color Codes Dialog Boxes

You can quickly look up all codes that have a color code associated with them by viewing a

sorted list in the applicable dialog box from the View menu.

Sticky Notes

You can add/edit your own comments to codes with sticky notes.

Printing

You can print the code information that appears in any dialog box.

What’s new in Encoder Pro 2.4?

Version 2.4 Data Updates

• 2001 CPT and color codes

• 2001 CPT lay descriptions

• 2001 CPT Assistant references

• 2001 HCPCS and color codes

• 2001 HCPCS annotations

• 2001 CPT and HCPCS code-specific modifiers

• 2001 Medicare coverage references

• 2001 Medicare Physician Fee Schedule

• CCI unbundle edits, version 7.0 (January 1 – March 31, 2001)

• 2001 ICD-9 to DRG crosscodes

Future Data Updates for 2001—Version 2.4.1

You can look forward to the following data updates in the next release of Encoder Pro scheduled

for April 2001.

• CPT surgery crosscoding data

• ICD-9 Vol. 3 to CPT crosscoding data

• Updated CCI unbundle edits

• 20001 CPT lay descriptions

New Enhancements in Version 2.4

Added Code Links in Many Dialog Boxes

More of the dialog boxes now contain links that jump you to the appropriate code in the Tabular

Listing. Dialog boxes with this enhanced feature added in 2.4 are Color Code dialog boxes,

Unbundles dialog box, Surgical Crosscodes dialog box, Procedural crosscodes dialog boxes, and

the CPT Guidelines dialog box (Primary Px Tab only).
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What’s New Feature Dialog Box

The first time you launch this version of Encoder Pro, a new dialog box will appear that will

show you what new features are in the latest version and will link to the online help. You must

select the X button in the upper right corner of the dialog box to close it.

New Copying Preferences

You can now set a preference that will allow you to copy the code’s full description, a 48-

character description, or a 35-character description. The shortened description is abbreviated

rather than truncated.

Large Fonts View

A new Large Fonts setting provides allows to view 125 percent larger fonts, without cutting off

any of the Encoder Pro main window or other dialog boxes. Changing this view is a Windows

function. You change this by going to the Windows Control Panel, select Display, select the

Settings tab, then in the in the lower left Font Size dropdown box, select Large Fonts.

Tab Position Storage

Dialog boxes which have multiple tabs will now store the last tab you accessed and display that

one the next time you access the dialog box.

Bigger Sticky Note Size

This new feature will allow up to 4,000 characters in sticky notes, up from the previous

256-character limit. This version also provides an expanded edit window within the Sticky Notes

dialog box that will allow you to easily view and edit long notes.

Index Modifiers in Teal

Specific diagnoses which are listed only in the ICD-9 index are now presented with their

appropriate code as teal text in the Tabular Listing. These index modifiers provide additional

information about the conditions that an ICD-9 code includes.

Software Requirements

Minimum System Requirements
*

• IBM, or compatible, Pentium 166 MHz; Pentium MHz recommended

• 32 MB RAM minimum, 64 MB RAM recommended

• Windows 95 B (or higher), Windows 98, Windows NT 4.x, and Windows 2000

• CD-ROM drive

*
Consult the Windows documentation for minimum system requirements to run Windows 95, Windows 98, and Windows NT 4.x on your

system
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• Mouse

• 50 MB required hard disk space

These optional accessories may make the software more efficient and/or allow you to better use

the HCFA-1500 form:

• VGA color adapter and monitor

• Printer—with at least 1MB RAM

Note: If you are using an Inkjet printer more than four years old, the HCFA-1500 form may not print
properly.

Installing the Software

Single-User Installation

Medicode’s Encoder Pro must be installed on a machine running Microsoft Windows 95 B,

Service Pack 2, or higher. For Windows NT, you must be running Service Pack 4.0 or higher.

1. Quit any open applications.

2. Insert CD into CD-ROM drive. The installation program will automatically start.

3. Follow the prompts in the installation program to complete the installation. As part of the

installation, you will be instructed to select a setup type. For single-user versions, select

Workstation. You will also be instructed to select a program group and a destination

drive. To perform a standard installation, select the default choices.

4. When installation is complete, it is recommend that you delete the previous version’s

shortcut icon from your desktop. To do this, go to your desktop and right-click on the

older version’s shortcut icon (e.g., Encoder Pro V2.3) and select Delete.

5. Now you can display the readme file within Microsoft Notepad. This file provides

instructions on how to install Adobe Acrobat Reader (available on the Encoder Pro CD-

ROM) and open the Encoder Pro User’s Guide electronic file (Eprohelp.pdf). You print

the readme file by selecting File/Print from the Notepad menu.

6. The first time you start Code It Fast, you will be prompted to register your program by

entering user and company name and the serial number from the registration card. Be sure

to fax or call in the registration card to Medicode.

Network Installation

The network version provides an administrator login from which global bookmarks and sticky

notes can be set for all workstations, and certain features can be restricted for all network users.

See “Network Administrator” on page 78 for instructions.

Important: You must have a network version of Encoder Pro to perform a network installation. Call

800-765-6797 if you have questions regarding the network version.
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1. Quit any open applications.

2. Insert CD into CD-ROM drive. The installation program will automatically start.

3. Follow the prompts in the installation program to complete the installation. As part of the

installation, you will be instructed to select a setup type. For network versions, select

Network. You will then be prompted to specify whether all users’ personal bookmarks

and personal sticky notes are saved locally (i.e., to the hard drive where the application

resides) or remotely (i.e., to the logged in users directory on the network). Rationale:

• Storing personal sticky notes remotely:  If you store sticky notes remotely, they will

be saved to a network folder and can then be accessed by a single user from any

workstation on the network.

• Storing personal sticky notes locally:  If you store sticky notes locally, only users

sitting at the workstation where their personal sticky notes are stored will be able to

access them.

Important: In a Novell server environment where you have chosen to store personal sticky notes
remotely, Encoder Pro will automatically store personal sticky notes to the user’s network

home directory. If the user does not have a mapped drive to their user directory, or if the

automatic search fails, or if you are in a non-Novell environment, you will be asked to select
a directory in which to store personal sticky notes on your network.

4. Follow the remaining prompts in the installation program to complete the installation.

You will be instructed to select a program group and a destination drive. The default is

the local drive (c:). Click Browse to specify a network drive as the installation drive.

5. When installation is complete, it is recommend that you delete the previous version’s

shortcut icon from your desktop. To do this, go to your desktop and right-click on the

older version’s shortcut icon (e.g., Encoder Pro V2.3) and select Delete.

6. Now you can display the readme file within Microsoft Notepad. This file provides

instructions on how to install Adobe Acrobat Reader (available on the Encoder Pro CD-

ROM) and open the Encoder Pro User’s Manual electronic file (Eprohelp.pdf). You print

the readme file by selecting File/Print from the Notepad menu.

7. The first time you start Code It Fast, you will be prompted to register your program by

entering user and company name and the serial number from the registration card. Be sure

to fax or call in the registration card to Medicode.

8. Once you install Medicode’s Encoder Pro on the network, you must set up each

individual workstation to run the application. See “Setting Up an Individual Workstation”

below for instructions.

Important: For Encoder Pro to function properly on network stations, all users must have read/write

access to the installation’s Data subdirectory.
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Setting Up an Individual Workstation

1. Once your network administrator has successfully installed the network version, go to the

next workstation where you want to install Encoder Pro.

2. Go to the Windows Start button and select Run.

3. Type in the pathname where your network administrator stored Encoder Pro, or click

Browse to navigate to that folder on the network. If your network administrator used the

default storage path, it will be at Medicode/Encoder Pro/Client Setup.

4. While still in the Run dialog box, double click on setup.exe.

5. Click OK.

6. Follow the prompts the complete the individual workstation installation.

How To Uninstall Medicode’s Encoder Pro

There are two methods to use to uninstall Encoder Pro. Both accomplish the same result.

Method A:

1. Double-click the uninstall icon (Uninst.exe) in the Medicode/Encoder Pro program folder

if you installed Encoder Pro in the default folders. If you installed Encoder Pro in a

different drive or folder, use Windows Explorer to find that folder.

2. Follow the instructions in the uninstall program to remove the executable and associated

program files from your system.

The uninstall program does not delete user-specific files for bookmarks, sticky notes, and user

registration. To remove these remaining files:

3. Open Window’s Explorer.

4. Select the Medicode folder (or the folder in which Medicode’s Encoder Pro resides) and

then select Delete from the File menu to remove user-specific files.

5. Go to the Start button, and select FindŸ Files or Folders.

6. In the Look In box, select your c: drive. In the Named box, type epro.bmk. Click the

Find Now button.

• If the utility finds the file, go the to File menu and select Delete.

• If the utility does not find the file, disregard and proceed to step 7 below.

7. While still in the Find dialog box, type epro.stk in the Look In box. Click the Find Now

button.

• If the utility finds the file, go the to File menu and select Delete.

• If the utility does not find the file, disregard and exit the dialog box.
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Method B:

1. Go to the Start button and select Settings Ÿ Control Panel to open the Control Panel

dialog box.

2. Double-click the Add/Remove Programs icon to open the Add/Remove Program

Properties dialog box.

3. From the Install/Uninstall tab, select Encoder Pro from the list of applications on your

PC.

4. Click the Add/Remove button to start the uninstall process.

5. After the application is uninstalled, close out of the Add/Remove Program Properties

dialog box(s).

The Add/Remove utility does not delete user-specific files for bookmarks, sticky notes, and user

registration. To remove these remaining files:

6. Open Window’s Explorer.

7. Select the Medicode folder (or the folder in which Medicode’s Encoder Pro resides) and

then select Delete from the File menu to remove user-specific files.

8. Go to the Start button, and select FindŸ Files or Folders.

9. In the Look In box, select your c: drive. In the Named box, type epro.bmk. Click the

Find Now button.

• If the utility finds the file, go the to File menu and select Delete.

• If the utility does not find the file, disregard and proceed to step 10 below.

10. While still in the Find dialog box, type epro.stk in the Look In box. Click the Find Now

button.

• If the utility finds the file, go the to File menu and select Delete.

• If the utility does not find the file, disregard and exit the dialog box.
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Performing a Code Search
This section explains how to use Medicode’s Encoder Pro to perform a code search. You learn

how to set search preferences, determine and enter key search terms, and use the spell check

feature.

Setting Preferences

Specifying Code Sets Using the Search Tab

When you first install Encoder Pro, the default preference is to include all code sets — ICD-9

Vol. 1 (diagnosis codes), ICD-9 Vol. 3 (procedure codes), CPT, and HCPCS — in every search.

To limit searches to a particular code set (or code sets):

1. Select Preferences from the Edit menu to open the Preferences dialog box.

2. From this dialog box, make sure that only those check box(es) of the code set(s) you want

to search are marked.

3. Select a check box to include the code set; clear the check box to exclude the code set.

Options

To select the search type:

• Click the Options drop-down arrow and select the search type you want.
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Match on all terms will locate only those matches that contain all of your search terms.

This is the default option when you first install the application. This is the recommended

search option.

Match on any term will list matches that contain one or more of your search terms. This

search option will return a broader list of results.

“Include Index Results in term searches” Check Box

When you enter search criteria, Encoder Pro searches both the standard code list and the Index

for matches. Since the addition of the Index search may slow the search speed, you can exclude

the Index from the search.

• Select this check box to include the Index search.

• Clear this check box to exclude the Index search. This will prevent the program from

searching the Index, and make the Index Results button unavailable.

Changing Sort Order (the View Tab)

To select the sort order of the search results:

1. In the Preferences dialog box, click the View tab.

2. Click the drop-down arrow and select the sort type you want.

Weighted ranking will arrange search results so the codes that best fit your search

criteria are listed first. This is the default option.

Alphanumeric listing will arrange code results in ascending alphanumeric order.
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Setting HCFA-1500 Print Preferences

1. In the Preferences dialog box, click the HCFA-1500 tab. You will see the following

tabbed page.

Print form in red. Select this option to print the form itself in red ink, and the data you

have entered in black ink. This feature is for color printers only. This is the default option.

Print claim entry contents only. Select this option to print only the data you have

entered onto a standard HCFA-1500 form.

Setting Network Preferences

The network administrator can specify under the Network tab of the Preferences dialog box

which features of the software users can access. To enable the system administrator privileges,

you must log in. See page 78 for further information.

Saving Preferences

• Click the OK button to save the preferences.

Entering Search Criteria

1. Type up to four key words or a code number at the Search Prompt.
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2. Press Enter to initiate a search. The software searches all selected code set databases for

a specific match based on the key words entered and the type of search option specified.

Deleted Codes

If you enter a deleted code number in the Search Prompt, or if you select Deleted Codes from the

View menu, the Deleted Codes dialog box appears similar to the following figure.

Deleted codes are maintained for the years 1998, 1999, 2000 and 2001. The Deleted Codes

dialog box shows deleted codes and their descriptions, the year each code was deleted, and any

cross-references. The dialog box contains a separate tab for each code set. Codes in each set are

arranged alphanumerically by code. When the dialog box opens, the deleted code you entered at

the Search Prompt is selected, but you can scroll through the list to view other deleted codes.

Note: You can open the Deleted Codes dialog box directly through the View menu. There is no tab for
ICD-9 codes because there are currently no deleted ICD-9 codes.
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Tips For Entering Search Terms

• Choose search terms that uniquely identify the service or supply.

• Enter as many identifying terms as possible (limit is four words). You can search on just

one word, but you get more specific results when you enter two or three search terms.

• Avoid entering too many search terms or search terms that are too specific; in these

instances there may be no results that exactly match your criteria.

• Avoid connecting words such as of, and, or, with, not, or punctuation such as commas,

periods, dashes, etc.

• To go directly to a code/description in the Tabular Listing, enter a code number. If the

number doesn’t exist (i.e., has been deleted or is otherwise invalid), the system displays

the next valid code for CPT codes, and the next valid category for ICD-9 codes. For

ICD-9 codes, you must enter a decimal for codes with additional digits.

• If doing a word search, do not enter numbers. For example, type “chest x-ray two views”

instead of “chest x-ray 2 views.” Unless you are entering a code number, the search

doesn’t recognize numbers.

• Encoder Pro recognizes several acronyms as search criteria. You can enter these terms

just as they appear in your documentation. Encoder Pro will automatically locate the

correct code(s).

• For example, to locate CPT codes for Computerized Axial Tomography, you can enter

the acronym “CAT.” To locate codes for arterial blood gases, you can type the acronym

“ABG.”

Determining Search Criteria

When choosing search criteria from your documentation, it is important that you use terms that

best identify the service or symptom. Entering the proper terms ensures that searching will be

quick and accurate. The suggestions below will help you determine which terms to enter as

search criteria.

Criteria for CPT Codes

To determine the criteria for a procedure code search, first ask yourself what was performed, and

where (anatomical site) it was performed. Generally, the first two words of your documentation

will identify what and where; enter these terms as search criteria. For example, the key terms

“arthroscopy shoulder” answers both what (arthroscopy) and where (shoulder). Entering these

two terms will bring up all codes containing arthroscopy and shoulder.

To further narrow the search, type one or two more terms that further explain the procedure. For

example, entering “arthroscopy shoulder decompression” will narrow the results to just one CPT

code, 29826, which contains all three terms. Avoid being too specific or entering too many

search terms; in these instances, there may be no results that exactly match your criteria. It is best

to choose two to four key search terms.
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Note: Some terms explain both what was performed and where. For example, the term colonoscopy
explains what was performed (scope) and where (colon).

Criteria for ICD-9 Codes

To identify the criteria for an ICD-9 Volume 1 code search, ask yourself why the patient received

care. From the documentation, pull up to four key terms that best describe the reason. For

example, if a shoulder arthroscopy was performed, ask yourself why. Entering “joint tear” will

return a large variety of matches in the Tabular Results. To return more specific results, include

the specific anatomical region. Entering “joint tear shoulder” returns only the diagnosis codes

that are specific to the shoulder.

To identify the criteria for an ICD-9 Volume 3 code search, ask yourself what kind of procedure

was performed (e.g., appendectomy, hysterectomy), and enter this term into the Search Prompt.

To further define your search, include the anatomical site where the procedure was performed

(e.g., abdominal region, pelvis).

Spell Checking Search Terms

When you enter a search term that is either incorrectly spelled or not found in the code databases,

the Search Term Alternative dialog box appears. Alternative search terms are listed for the

search term you originally entered, and are based on the first letter of that term or a phonetic

match.

To select an alternative search term:

1. Scroll through the list to find the desired search term.

2. Select the term you want.

3. Click Accept to close the Search Term Alternative dialog box and continue the search

based on the alternative term.

To continue the search without a search term alternative, click Skip. This will remove the term

from your search.
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Viewing Search Results
After you execute a search, the Tabular Results box displays matches found in all applicable code

sets.

A mark in a code set check box indicates results were found; a dimmed check box means no

results were found for the code set.

The Tabular Results box displays the total number of results, including the subsection range that

the code(s) belong to for all CPT and HCPCS results (see page 18 for more information about

CPT and HCPCS subsection ranges). The Tabular Results box shows “0” if no results were

found.

When you point to a code description that scrolls off the screen, Encoder Pro displays the full

description in a code popup similar to the example below.

You can also use the scroll bars to view entire code descriptions and additional results.

Viewing Additional Digit ICD-9 Codes

ICD-9 codes with additional digits are consolidated into a common category. Codes that require

additional digits have a plus sign  to the left.
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• Click the plus to expand the category and display subcodes.

• Click the minus sign  to hide subcodes.

Note: Only those subcodes that pertain to the search results are listed; not all third-, fourth- and/or
fifth-digit codes are listed.

Viewing CPT and HCPCS Codes

CPT and HCPCS codes are consolidated into subsections identified by the range of codes in that

subsection. For example, if CPT code 21031 Excision of torus mandibularis is part of your

results, it will be listed under this subsection range: 21015-21070 Musculoskeletal System, Head,

Excision.

Each subsection range has a plus sign  to the left.

• Click the plus to expand the subsection listing and display codes.

• Click the minus sign  to hide codes.

Note: Only those codes that pertain to the search results are listed; not all codes in the subsection are
listed.

Specifying Code Sets

You can “filter” the results displayed by selecting or clearing check boxes:

1. Select the check box for each code set in which you want to view results—ICD-9, CPT,

and/or HCPCS.

For example, if you want to view just ICD-9 code results, make sure that only the ICD-9

check box is marked.
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A mark in the check box indicates a code set is selected. If a check box is dimmed, no

results were found and the check box cannot be selected or cleared.

The check boxes that are marked are based on the results found for your search. The code

sets you are searching on are based on your preferences set through the Preferences

dialog box from the Edit menu.

2. Reference the Tabular Results box to see how many results were found for the code set(s)

selected.

The Tabular Results field automatically updates when you select (or clear) the code set

check boxes.

Narrowing Search Results
Every time you perform a search, the Tabular Results box shows how many code matches were

found. Clicking the Narrow button allows you to select additional search criteria to narrow down

the number of results.

Specifying Code Type

Many search terms bring back results from multiple sections of ICD-9, CPT, and/or HCPCS

(e.g., the Tabular Results may list codes from the surgery, radiology, and medicine sections of

CPT, and/or may list codes from ICD-9 Volume 1 and ICD-9 Volume 3). If you have performed

this type of search, the Specify Code Type dialog box will appear the first time you click the

Narrow button . This dialog box allows you to narrow your search results by including

(or excluding) only those code range sections that are appropriate.

Notes: The Specify Code Type dialog box appears only for the code sets you select before initiating a
search. For example, if you search on “biopsy” but only have the ICD-9 check box marked when

you click Narrow, you won’t see the range categories tab for CPT codes, even if CPT codes
appeared in your initial tabular results. You must initiate the search again and make sure the CPT

check box is marked when you click Narrow.

Clicking the Narrow button a second time will open the Select Additional Search Criteria dialog
box explained in the following section.

If the search results do not list codes from multiple sections of ICD-9, CPT, and HCPCS, the

Specify Code Type dialog box will not open when you first click the Narrow button; instead you

will see the Select Additional Search Criteria dialog box.



E N C O D E R  P R O  U S E R ’ S M A N U A L 20

VERSION 2.4

In the Specify Code Type dialog box a tab appears for each code set (ICD-9, CPT, and HCPCS)

that has results listed for multiple code ranges. Depending on the search, this dialog box may

display a tab for just one code set, two, or all three.

For example, the search term “ankle” triggers code results from all three code sets (ICD-9, CPT,

and HCPCS). Code ranges are as follows:

ICD•9 CPT HCPCS
Diagnosis Evaluation and Management Transportation Services
Procedures Anesthesiology Chiropractic Services
Health Status Factors Surgery Prof/Medical Services
External Causes Radiology Path/Lab Services

Path/Lab Dental Supplies/Services
Medicine Med/Surg Supplies

DME
Drugs
Miscellaneous/Temporary

Using the previous example, if you are looking for a CPT surgery code and your search term

(e.g., “ankle”) occurs in CPT codes in anesthesiology, surgery, radiology, and medicine, you

would select the Surgery check box under the CPT Range Categories tab to limit the CPT search

results to codes from the Surgery section only.

Selecting Additional Search Criteria

The Select Additional Search Criteria dialog box is a second way you use the Narrow button

to narrow down your search results.

• If your search results do not contain codes from multiple sections of ICD-9, CPT, and/or

HCPCS, this dialog box appears when you first click the Narrow button.

• If your search results do contain codes from multiple sections of ICD-9, CPT, and/or

HCPCS, you must specify the code section type first (see “Selecting Code Type” in the

previous section) and then click the Narrow button a second time to display the Select

Additional Search Criteria dialog box.



E N C O D E R  P R O  U S E R ’ S M A N U A L 21

VERSION 2.4

From the Select Additional Search Criteria dialog box, you select the category and term that

further identifies the anatomy, diagnosis, treatment, supply, or other criteria specific to your

search. The terms available at each Select Additional Search Criteria dialog box are specific to

the search results for the current search.

Use the Narrow button as often as necessary to pare down the search results by selecting

additional search terms.

• Each time you click the Narrow button and further define your search criteria a new list

of results is generated.

• The Tabular Results box keeps a count of the results found.

• Click and hold the down arrow at the Search Prompt to view all terms entered and

selected through the Select Additional Search Criteria dialog box for the current search.

Previous Button

After you use the Narrow button to view a level of more specific results, you can click the

Previous button to go back to the previous (broader) level of search results. This button is not

available when you first perform a search because the first listing of results is the broadest level.

Viewing Index Results

You find codes in the ICD-9, CPT, and HCPCS books by either searching the tabular listing or

looking in the Index. Similar to the books, you can use Encoder Pro to view codes for the current

search as they are displayed in the Index, as well as view codes in the Tabular Listing.
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To view the Index Results:

1. Type search criteria into the Search Prompt.

2. Press Enter.

If the search criteria you enter is found in the Index, the Index Results button is enabled.

If no results in the Index match your search criteria, the Index Results button will remain

disabled.

3. Click Index Results to open the Index Results dialog box.

The Index Results dialog box displays a separate tab for codes located in each applicable code

set index:  ICD-9 Vol. 2 (the index for ICD-9 Vol. 1 codes), ICD-9 Vol. 3, CPT, and HCPCS.

• To view subcodes, click the plus box in front of a main code.

• Click the minus box to hide subcodes.

Note: You can speed up your searches by excluding the Index from the search. See the Preferences
section on page 12 for details.

Viewing Codes in the Tabular Listing

Either select a magenta-colored code in the Index Results window and click OK, or double-click

the desired code to view that code in the Tabular listing.

When you view a code in the Tabular Listing, the Index Results window remains open.

If Tabular Results Aren’t Found

If you execute a search and Encoder Pro doesn’t find any matches in the Tabular Listing, but

does find results in the Index, the Tabular Results is dimmed, and the following message appears.
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• Click Cancel to close the message and return to the Search Prompt.

• Click Index Results to open the Index Results window.

Tabular Listing
Viewing the selected code in the Tabular Listing is like looking up the code and description in

the tabular listing of the ICD-9, CPT, or HCPCS code book.

Once you’ve narrowed your search results sufficiently, select any code in the Tabular Results to

see it in the Tabular Listing on the right side of the screen. The Tabular Listing displays which

section of the appropriate book the code falls under, the full description for the selected code and

all neighboring codes, and any applicable color codes. The Tabular Listing is presented in three

panes:

• Section Headers. This is a drop-down list and displays section titles that identify where

in the ICD-9, CPT, or HCPCS code book a group of codes are located. This pane defaults

to the lowest level category in the book, but by using the drop-down list you will see any

of the higher levels if needed.

• Tabular Listing. This pane shows you the full description for the selected code and all

neighboring codes.

• Color Code Box. This is where the color code symbols are displayed. Only the color

code symbols applicable to the selected code are shown. Add-on Codes have blue

hyperlinks to the Primary PX tab of the CPT Guidelines dialog, and will take you there if

you click on them.
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ICD-9 Tabular Listing

The ICD-9 Tabular Listing arranges codes according to three-digit categories for Volume 1

codes, and two-digit categories for Volume 3 codes. You see the includes and excludes notes and

government notes and instructions that affect all codes in each category. Codes that require

additional digits are shown in red. Index modifiers (specific diagnoses which are listed only in

the index) are now presented with their appropriate code as teal text in the Tabular Listing.

Use the scroll bar (if necessary) to view all information within a category.

ICD-9 Color Coding Symbols

ICD-9 color coding symbols provide further information for diagnosis codes (e.g., codes that

require an additional digit, are nonspecific, are new, etc). For more details, see “ICD-9 Color

Coding Key” on page 29.



E N C O D E R  P R O  U S E R ’ S M A N U A L 25

VERSION 2.4

Viewing Previous/Next Codes

  Click the up/down arrows from the button bar to change the Tabular Listing display to the

previous/next two- or three-digit category.

Viewing Additional Digit ICD-9 Codes

ICD-9 Volume 1 codes are displayed within the context of the three-digit category. Volume 3

codes are displayed within the two-digit category. This ensures that you see category-wide

information that applies to fourth- and fifth-digit codes. For example, the Tabular Listing for

fourth-digit code 056.7 displays both the three-digit category (056) and all applicable fifth-digit

codes in that category. Note that any code that requires additional digits is listed in red font, even

if that code is not selected.

Cross-Referencing ICD-9 Codes in the Tabular Listing

• Double-click any cross-reference codes in the includes/excludes notes to identify it as the

selected (highlighted) code.

For example, if you double-click 771.0, which is referenced in the excludes note for

category 056, the Tabular Listing redisplays, showing the codes and descriptions (with

hierarchy) for 771.0.

• Click the originally selected code in the Tabular Results or use the History menu to return

to the Tabular Listing for the first code.

CPT and HCPCS Tabular Listing

For CPT and HCPCS codes, the Tabular Listing displays the code and full description for the

selected code and a screen-view of all other CPT codes in the same section/subsection. CPT and

HCPCS codes in the Tabular Listing are grouped by section/subsection. The top pane of the

Tabular Listing displays section titles that identify where in the CPT or HCPCS books a group of

codes are located. Use the scroll bar if necessary to view the top of the Tabular Listing.

Color Coding Symbols

CPT color coding symbols shown in the bottom pane identify starred procedures, add-on

(subsidiary) codes, add-on codes with a diagnosis that is different than that of the corresponding

principal procedure code, codes for which modifier -51 is exempt, new and revised codes, and

nonspecific (unlisted) codes. See “CPT Color Coding Key” on page 37 for more details.

For HCPCS, color coding symbols shown in the bottom pane identify codes that aren’t covered

by or valid for Medicare, have special coverage instructions, are reimbursed based on carrier

discretion, are new, are revised, or have a quantity associated with them. See page 41 for more

details.

Viewing Previous/Next Codes

  Click the up/down arrows from the toolbar to change the Tabular Listing display to the

previous/next section of codes.
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Code-Specific Dialog Boxes
You can quickly view additional information from Medicode’s top-selling publications for the

selected code. You can open various dialog boxes for ICD-9, CPT, and HCPCS codes selected

from the Tabular Listing. This code-specific information is accessed from the buttons that appear

at the top of your screen, as well as from the ICD-9, CPT, or HCPCS menu (the name of the

menu changes depending on the type of code selected in the Tabular Listing). The code-specific

dialog boxes that are available are specific to the type of code selected. See ICD-9 Dialog Boxes.

CPT Dialog Boxes, and HCPCS Dialog Boxes in the following pages for the various dialog

boxes you are able to access depending on the code(s) selected.

This section explains each code-specific dialog box. First, it shows all dialog boxes available for

ICD-9 codes, then dialog boxes for CPT codes, and finally those available for HCPCS codes.

Notes: You must select a code in the Tabular Results to identify it as a selected code and display it in the
Tabular Listing.

If a dialog box is not available for the selected code, the corresponding button and menu option
are dimmed to indicate that the information is not applicable to that particular code.

ICD-9 Dialog Boxes

Tabular Section Notes

Click this button to view section notes and AHA Coding Clinic references. This dialog box

contains two tabs: Section Notes and References.

Section Notes. This tab displays notes that apply to the selected code. These notes, which appear

at the beginning of certain sections in the Tabular Listing of ICD-9, further define terms, clarify

information, and provide fifth-digit information. They also contain includes and excludes notes

that pertain to the selected code.
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References. This tab displays references for the AHA’s Coding Clinic, the official publication

for the ICD-9 guidelines. It references Coding Clinic editions and page numbers in which the

selected code has been discussed. The year is listed, then the range of months (for issues

published before 1988) or the quarter, then the page number of the reference. For copies of the

Coding Clinic, contact the AHA at 800-261-6246.

Annotations  

Click this button to view annotations that apply to the selected ICD-9 code. Annotations provide

explanations of medical terminology and descriptions for specific diseases or conditions.

ICD-9 Volume 3 to CPT Crosswalk  

Click this button to view CPT surgical codes that are crossed to the selected ICD-9 Volume 3

procedural code.

This dialog box contains bold magenta code number links that jump you to the appropriate code

in the Tabular Listing. You can access the links by double-clicking or by clicking and then

pressing the Select button.
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DRG Crosscodes  

Click this button to view the DRGs (Diagnostic Related Groups) that are crossed to the selected

ICD-9 code. Values used for Medicare reimbursement calculations are also provided.

DRG Code and Description. DRGs are groups of ICD-9 codes that report inpatient services to

Medicare, Medicaid, and some private payers. DRGs standardize payment by illness and

treatment, allowing reimbursement to be predicted prospectively, before care is provided. DRGs

are defined as either medical or surgical.

MDC (Major Diagnostic Category). Each DRG falls into an MDC category. This classification

of diagnoses typically grouped by anatomic system is the basis for the DRG prospective payment

system.

GMLOS, AMLOS, and RW. The geometric mean length of stay (GMLOS), arithmetic length

of stay (AMLOS), and relative weight (RW) are used for the Medicare reimbursement

calculation for a particular DRG. The length of stay is averaged for the given DRG and GMLOS

and is weighted to allow for outliers and other factors that skew data and potentially change

reimbursement. The RW is a comparative, assigned weight to indicate relative resource

consumption associated with the given DRG. The higher the relative weight, the greater the

reimbursement. The relative weight is multiplied by a facility’s conversion factor to produce the

dollar amount to be paid the facility.
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ICD-9 Color Coding Legend

Click this button to view a key of different ICD-9 color coding symbols.

The following explains each ICD-9 color coding symbol.

Additional Digits Required. The red circle with a slash identifies codes that require an

additional fourth and/or fifth digit for Volume 1 codes, or an additional third and/or fourth digit

for Volume 3 codes to be coded correctly. Either the code category or subcategory contains more

specific codes, or the code choices are listed with the main category.

Note: A red stop sign was previously used to identify ICD-9 codes requiring additional digits. This color
coding symbol has been replaced with the red circle with a slash to better distinguish it from the
red circle used to identify new codes.

New Code. The solid red circle identifies ICD-9 codes that are new for 2001.

Revised Code. The turquoise triangle identifies revised ICD-9 codes for 2001.

Adult Diagnosis. The black “A” enclosed in a box identifies ICD-9 codes that are considered an

adult diagnosis.

Newborn Diagnosis. The black “N” enclosed in a box identifies ICD-9 codes that are considered

a newborn diagnosis.

Pediatric Diagnosis. The black “P” enclosed in a box identifies ICD-9 codes that are considered

a pediatric diagnosis.

Male Diagnosis. The blue male symbol identifies ICD-9 codes that are considered a male

diagnosis.

Female Diagnosis. The blue female symbol identifies ICD-9 codes that are considered a female

diagnosis.
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Comorbidity or Complication. The solid blue square with “CC” in white font identifies ICD-9

codes that are related to comorbidity or a complication.

Nonspecific Code. The yellow caution sign indicates that a code is classified as “unspecified,”

“other,” or “ill-defined.” Codes identified by this symbol are also known as “dump” codes or

“catch-all” codes. A “nonspecific” code can be a valid choice if it most closely describes your

diagnosis, but use these codes only after checking all other options.

Not a Primary Diagnosis. The blue rectangle identifies codes that do not report primary

diagnoses. Also known as “manifestations,” these codes should only be listed as secondary

diagnoses where appropriate. Simply stated, these codes are never used alone.

Non-OR Procedure. The blue yield sign identifies non-operating room (Non-OR) procedures (as

determined by the DRG grouper) that affect DRG assignment.

Valid OR Procedure. The green arrow identifies operating room (OR) procedures (as

determined by the DRG grouper) that may affect DRG assignment.

Noncovered. The black circle with a slash identifies ICD-9 Vol. 3 codes that are not covered by

Medicare.

Sticky Notes. The pink flag identifies codes with attached sticky notes. See page 53 for details

on using sticky notes.

CPT Dialog Boxes

CPT Guidelines

Click this button to view CPT guidelines, parenthetical commentary, AMA CPT Assistant

references that apply to the selected CPT code, and primary procedure codes that are appropriate

for use with CPT add-on codes. This dialog box contains four tabs: Section Notes, Instructions,

References, and Primary Px. Note that tabs will only appear if they apply to the selected CPT

code.
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Section Notes. This tab displays information that appears at the beginning of sections or

subsections in CPT for the selected code.

Instructions. This tab displays CPT parenthetical commentary for the selected code.
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References. This tab displays references for the American Medical Association’s CPT Assistant,

the official publication for the AMA guidelines. It references CPT Assistant editions and page

numbers in which the selected code has been discussed. The year is listed, then the quarter, then

the page number of the reference. For copies of the CPT Assistant, contact the AMA at

800-621-8335.

Primary Px. This list shows the primary procedure code(s) appropriate for use with the selected

add-on code.

This tab contains bold magenta code number links that jump you to the appropriate code in the

Tabular Listing. You can access the links by double-clicking or by clicking and then pressing the

Select button.
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CPT Lay Descriptions  

Click this button to view a nonclinical description (or extended annotation) of the selected CPT

code. CPT lay descriptions are available for most surgical and medicine codes.

Modifiers  

Click this button to view a list of CPT and HCPCS modifiers that may be used with the selected

CPT code.

Unbundles

This button displays CPT codes that have unbundle edits based on Medicare’s Correct Coding

Initiative. It shows CPT codes that should not be billed with the selected CPT code. The reason

for the unbundle edit, as defined by the Medicare Correct Coding Initiative, is also shown.

This dialog box contains bold magenta code number links that jump you to the appropriate code

in the Tabular Listing. You can access the links by double-clicking or by clicking and then

pressing the Select button.
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CCI Component. These unbundles are part of Medicare’s Correct Coding Initiative edit. If the

selected CPT code represents a comprehensive procedure, these unbundles list the CPT codes

that represent the components of the comprehensive procedure.

CCI Mutually Exclusive. These unbundles are part of Medicare’s Correct Coding Initiative edit.

Codes listed here represent those procedures that cannot be performed during the same operative

session.

Note: The Commercial Payor tab, which was available in version 2.2 of Encoder Pro, has been
removed because this data is no longer maintained by Medicode.

Surgical Crosscodes  

Click this button to view ICD-9 diagnosis (Volume 1) and procedure (Volume 3) crosscodes.

When applicable, this dialog box also displays HCPCS codes, ADA codes, and CPT anesthesia

codes that are crossed to the selected CPT surgical code.

This dialog box contains bold magenta code number links that jump you to the appropriate code

in the Tabular Listing. You can access the links by double-clicking or by clicking and then

pressing the Select button.
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Medicare Information  

Click this button to view Medicare information for the selected CPT code. When applicable, this

dialog box displays Relative Value information, Global Information, and specific Medicare Rules

from the 2000 Medicare Physician Fee Schedule.

Note: Because Medicare information is now taken from the 2001 Medicare Physician Fee Schedule,
which doesn’t include anesthesia base units, anesthesia base units are no longer provided in
Encoder Pro.

The following describes information in each tab of the Medicare Information dialog box.

RVUs – Facility. This tab shows relative value units (RVUs) for procedures performed in a

hospital, skilled nursing facility or an ambulatory surgery center.

The RVUs are broken out into the components of physician work (Work RVU), practice expense

(PE RVU), and malpractice relative value units. The total RVU is also supplied. The 2000

conversion factor, 36.6137, is displayed at the bottom of the dialog box.

RVUs – Nonfacility. This tab shows relative value units (RVUs) for procedures performed in a

physician’s office, patient’s home, or any other facility or institution, such as a residential care

setting, that is not a hospital, SNF or ASC.

The RVUs are broken out into the components of physician work (Work RVU), practice expense

(PE RVU) and malpractice relative value units. The total RVU is also supplied. The 2000

conversion factor, 36.6137, is displayed at the bottom of the dialog box.
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Global Information. This tab shows global period information for the selected CPT code. The

global period is the time following surgery during which routine care by the physician is

considered postoperative and included in the surgical fee. Office visits or other routine care

related to the original surgery cannot be separately reported if they occur during the global

period. Global periods are sometimes referred to as “follow-up days” or FUDs.

The Global Split section shows a breakdown of how Medicare expects the value of an encounter

to be split if different components of the encounter are performed by different physicians.

You see the percentages that would be paid to physicians for preoperative, intraoperative, and

post operative services, if these services were performed separately.
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Medicare Rules. This tab lists the Medicare edits that are applicable to the selected CPT. Each

rule is listed and explained in detail in the online Help.

CPT Color Coding Legend

Click this button to view a key of different CPT color coding symbols.

The following explains each CPT color coding symbol.

Service Includes Surgical Procedure Only. The green star indicates services that include the

surgical procedure only (starred procedures). Associated pre-and postoperative services are not

included.

New Code. The red circle indicates new CPT codes.



E N C O D E R  P R O  U S E R ’ S M A N U A L 38

VERSION 2.4

Revised Code. The turquoise triangle indicates CPT codes with revisions; codes with minor

terminology changes are not identified.

Add-on code with Different Diagnosis. The blue rectangle indicates add-on codes for which the

diagnosis is different than that for the principal procedure.

Modifier -51 Exempt. The black circle with a slash indicates codes for which modifier -51 is

exempt.

Add-on code (AMA). The black plus sign indicates add-on (subsidiary) codes as identified by

the American Medical Association in CPT 2000. The principal procedure code(s) that the add-on

code is supplemental to are listed after the code description in the Tabular Listing.

Add-on code (Medicode). The red plus sign indicates additional add-on codes as identified by

Medicode clinicians. The principal procedure code(s) that the code is supplemental to are listed

after the code description in the Tabular Listing.

Nonspecific Code. The yellow diamond indicates nonspecific CPT codes (i.e., unlisted codes).

Sticky Notes. The pink flag indicates codes with attached sticky notes. See page 53 for details on

using sticky notes.

HCPCS Dialog Boxes

HCPCS Section Notes  

Click this button to view section notes for the selected HCPCS code. These notes appear at the

beginning of certain sections in the HCPCS book. HCPCS section notes include ambulance

origin modifiers, destination modifiers, and PET scan modifiers.
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Annotations  

Click this button to view a description or explanation of the selected HCPCS code. Annotations

provide more information about medical and surgical supplies, durable medical equipment,

drugs, and certain professional services.

Modifiers  

Click this button to view a list of CPT and HCPCS modifiers that are appropriate for the selected

HCPCS code. Modifiers that include ambulance origin, destination modifiers, and PET scan

modifiers are listed in the HCPCS Section Notes.

Unbundles

This button displays HCPCS codes that have unbundle edits based on Medicare’s Correct Coding

Initiative (CCI). It shows CPT codes that should not be billed with the selected HCPCS code.

The reason for the unbundle edit, as defined by the Medicare Correct Coding Initiative, is also

shown.

This dialog box contains bold magenta code number links that jump you to the appropriate code

in the Tabular Listing. You can access the links by double-clicking or by clicking and then

pressing the Select button.



E N C O D E R  P R O  U S E R ’ S M A N U A L 40

VERSION 2.4

CCI Component. These unbundles are part of Medicare’s Correct Coding Initiative edit. If the

selected HCPCS code represents a comprehensive procedure, these unbundles list the HCPCS

codes that represent the components of the comprehensive procedure.

CCI Mutually Exclusive. These unbundles are part of Medicare’s Correct Coding Initiative edit.

Codes listed here represent those procedures that cannot be performed during the same operative

session.

Special Coverage Instructions  

Click this button to view special coverage instructions from these applicable Medicare

references: Coverage Issues Manual and Medicare Carriers Manual.
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HCPCS Color Coding Legend

Click this button to view a key of different HCPCS color coding symbols. Color coding symbols

identify special Medicare coverage issues affecting HCPCS codes.

The following explains each HCPCS color coding symbol.

New Code. The red circle identifies new HCPCS codes.

Revised Code. The turquoise triangle identifies revised HCPCS codes.

Special Coverage Instructions. The green question mark means that special coverage

instructions apply to the selected code. Click the Medicare Information button to read pertinent

Coverage Issues Manual (CIM) and Medicare Carriers Manual (MCM) references.

Carrier Discretion. The purple arrow identifies codes that require carrier discretion. Contact

your carrier for specific coverage information for these codes.

Not Covered By or Valid for Medicare. Codes that are not covered by or valid for Medicare are

identified by the black circle-slash. Click the Medicare Information button to read pertinent CIM

and MCM references.

Quantity Alert. Codes that have an amount associated with them are displayed with a red box

with a white background containing a red √.

Sticky Notes. The pink flag identifies codes with attached sticky notes. See page 53 for details

on using sticky notes.
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Looking Up Codes Which Have Color Symbols
The CPT, ICD-9 and HCPCS Color Codes dialog boxes found under the View menu let you see

codes that are assigned a certain color code. For example, you can quickly reference all ICD-9

codes that are new and/or revised for 2001. Or, you can see all CPT codes that are add-on codes.

These dialog boxes are for reference only and do not support printing.

CPT Color Codes

To open the CPT Color Code dialog box:

• From the View Menu, select CPT Color Codes.

This dialog box allows you to look up all CPT codes assigned color codes. It has tabs for New,

Revised, Add-on, -51 Exempt, and Starred Px.

All five subordinate tabs contain a Find field that acts as a Go To button to maneuver within the

Codes column. This is not a “search” filter, and will only accept from 1 to 5 digits.

The data presented in these 5 tabs is the same no matter what code has been selected in the

Tabular Listing or Results.

This dialog box contains bold magenta code number links that jump you to the appropriate code

in the Tabular Listing. You can access the links by double-clicking or by clicking and then

pressing the Select button.

• New. The New tab shows all new CPT codes and their descriptions. The Code and

Description columns are not sortable.
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• Revised. The Revised tab shows all revised CPT codes and their descriptions. The Code

and Description columns are not sortable.

• Add-on. The Add-on tab shows all CPT Add-on codes. It has three columns. The Code

column shows all CPT Add-on codes and is sortable. The Type column lists whether add-

on codes have been defined by Medicode or the AMA. The Description column is not

sortable.
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• -51 Exempt. The -51 Exempt tab shows all CPT codes and their descriptions that should

not be used with Modifier -51. The Code and Description columns are not sortable.

• Starred Px. The Starred Px tab shows all the Starred Procedures (the service listed

includes only the surgical procedure, no associated pre- and postoperative services). The

Code and Description columns are not sortable.

ICD-9 Color Codes

To open the ICD-9 Color Code dialog box:

• From the View Menu, select ICD-9 Color Codes.

This dialog box allows you to look up all ICD-9 codes assigned color codes. It has tabs for New,

Revised, CC, OR, Age, and Sex.

Note: Tabs for nonspecific and noncovered color codes are not available.
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All six subordinate tabs contain a Find field that acts as a Go To button to maneuver within the

Codes column. This is not a “search” filter, and will accept from 1 to 6 digits (including the “V”

and a decimal point if applicable).

The data presented in these 6 tabs is the same no matter what code has been selected in the

Tabular Listing or Results.

This dialog box contains bold magenta code number links that jump you to the appropriate code

in the Tabular Listing. You can access the links by double-clicking or by clicking and then

pressing the Select button.

• New. The New tab shows all new ICD-9 codes which have a color code and their

descriptions. The Code and Description columns are not sortable.

• Revised. The Revised tab shows all ICD-9 codes that have been revised and their

descriptions. The Code and Description columns are not sortable.
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• CC. The CC tab shows all Complication and Comorbidity codes (diagnoses that affect

DRG assignments) and their descriptions. The Code and Description columns are not

sortable.

• OR. The OR tab shows all Operating Room procedure and their descriptions. The Code

and Description columns are not sortable.
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• Age. The Age tab shows all ICD-9 codes that are age related. It has three columns. The

Code column provides the ICD-9 code and is sortable. The Age column shows the

applicable age category (e.g., Adult, Newborn) and is sortable. The Description column

is not sortable.

• Sex. The Sex tab shows all ICD-9 codes that are attributable to either a male or female

diagnosis. It has three columns. The Code column provides the ICD-9 code and is

sortable. The Sex column shows the gender for which the procedure is intended and is

sortable. The Description column is not sortable.
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HCPCS Color Codes

To open the HCPCS Color Code dialog box:

• From the View Menu, select HCPCS Color Codes.

This dialog box allows you to look up all HCPCS codes assigned color codes. It has tabs for

New, Revised, Quantity, and Medicare. All four subordinate tabs contain a Find field that acts as

a Go To button to maneuver within the Codes column. This is not a “search” filter, and will

accept from 1 to 5 digits (including the alphanumerics).

This dialog box contains bold magenta code number links that jump you to the appropriate code

in the Tabular Listing. You can access the links by double-clicking or by clicking and then

pressing the Select button.

• New. The New tab shows all new HCPCS codes which have a color code and their

descriptions. The Code and Description columns are not sortable.

• Revised. The Revised tab shows all HCPCS codes that have been revised and their

descriptions. The Code and Description columns are not sortable.
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• Quantity. The Quantity tab shows all HCPCS codes which have any quantity associated

with them and their descriptions (including amounts). The Code and Description columns

are not sortable.

• Medicare. The Medicare tab shows all the HCPCS codes that are exclusive to Medicare.

It has three columns. The Code column shows the HCPCS code and is sortable. The

Coverage column indicates whether the code is used at the carrier’s discretion, or has

special instructions, and is sortable. On codes containing special instructions, double-

clicking the blue link takes you to a Special Coverage Instructions dialog box that

provides further information regarding Medicare’s special instructions. The Description

column is not sortable.
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Looking Up Codes Quickly
Click any code in the Tabular Results to go to that code in the Tabular Listing. There are four

additional ways to locate a code in the listing:

• Enter the code number at the Search Prompt (see “Performing a Code Search” on page 11

for instructions).

• A list of codes that you have selected during the current lookup session is listed in the

History menu (previously called the Go menu). Use the trail in the History menu to go

back to codes already selected. This code trail shows the 15 latest code selections, with

the most recent at the top.

The History menu shows codes entered as number searches as well as the selected codes.

• Select codes from the Bookmarks dialog box.

• Select codes from the Sticky Notes dialog box.

Using Bookmarks  
The Bookmarks dialog box displays a ready-reference list of “bookmarks” for codes that you

regularly use. These place markers are a convenient way to go directly to the Tabular Listing for

a selected code.

This dialog box contains bold magenta code number links that jump you to the appropriate code

in the Tabular Listing. You can access the links by double-clicking or by clicking and then

pressing the Go to Bookmark button.

Note: The Bookmarks dialog box doesn’t contain any codes when you first install this application. You

must add all codes to the dialog box. If you are installing over a previous version, all bookmarks
will be preserved. Please see “Updating Bookmarks from a Previous Version” on page 52 for
additional information.

To open the Bookmarks dialog box:

• Click the Bookmarks button, or select Bookmarks from the View menu.
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Bookmarks are arranged by code set type. Click the appropriate button to view ICD-9,

CPT, or HCPCS bookmarks.

Network Version Note: If you have the network version of this application, the Bookmarks dialog box

contains a Global tab. Click this tab to view global bookmarks added by the
network administrator. To add, edit, or delete a global bookmark you must login

as the administrator by selecting Administrator Login under the File menu.
See “Network Administrator” on page 78 for instructions.

Adding a Bookmark

You can add as many codes to the bookmark list as you want.

To add a bookmark:

1. From the Tabular Listing, select the code that you want to add to the bookmarks list.

2. Open the Add Code dialog box by doing one of these actions: Click the Add button,

select Insert from the Edit menu, or press Ctrl+I.

The Add Code dialog box lists the code and description of the selected code. You choose

to add the code to the bookmarks list, notepad, HCFA-1500 form, and/or create a sticky

note for the code.

3. Select the Bookmarks check box to specify you are adding a bookmark.

4. Click OK to enter the code and description into the bookmarks list.

Shortcut

To quickly add a code to the Bookmarks dialog box without opening the Add Code dialog box:

Right-click the desired code in the Tabular Listing.

The Add Code shortcut menu will appear. Select Add to Bookmarks.

The code is automatically added to the Bookmarks dialog box.
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Editing a Bookmark

To edit a bookmark description:

1. Select the bookmark you want to edit.

2. Click the Edit button. You will see the Edit Description dialog box.

3. When you finish making changes to the description, click OK.

Deleting a Bookmark

To delete a code from the bookmark list:

1. Select the bookmark you want to delete.

2. Click Delete.

Note: Right-click in the code list to open the Bookmarks shortcut menu. Use this menu as another way to

edit, delete, or go to a selected code in the Tabular Listing.

Updating Bookmarks from a Previous Version

All bookmarks created in a previous version of Encoder Pro are preserved when you install a new

version, as long as you install the new version in the same directory as the previous version. As

Encoder Pro updates bookmarks from the previous version, it checks to see if there are any

bookmarks assigned to codes that are now invalid (i.e., codes that are deleted under the new

version). If there are any bookmarks assigned to invalid codes, the Bookmarks Update dialog box

appears when you open the Bookmarks dialog box.
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From this dialog box you can choose one of two options:

• Delete removes all bookmarks assigned to invalid codes.

• Save keeps all bookmarks assigned to invalid codes.

If Save is selected, the invalid codes will be listed in the Bookmarks dialog box with the

bookmark name (the default, unedited bookmark name is the full description).

You can use Encoder Pro to assign a new bookmark to a valid code. Once this is done, you can

use the Delete button to delete the invalid code from the Bookmarks dialog box (see “Deleting a

Bookmark” on page 52).

If you continue to list bookmarks for invalid codes, the Update Bookmarks dialog box will

appear each time you open the Bookmarks dialog box. If you don’t want the dialog box to

appear, select the “Discontinue showing this dialog” check box.

Using Sticky Notes  
Sticky Notes allow you to enter or read custom notes for selected codes. Codes are arranged by

code set type. Click the appropriate option to view ICD-9, CPT, or HCPCS sticky notes.

This dialog box contains bold magenta code number links that jump you to the appropriate code

in the Tabular Listing. You can access the links by double-clicking or by clicking and then

pressing the Go to Code button.

Note: The Sticky Notes dialog box doesn’t contain any codes or sticky notes when you first install this
application. You must add all codes and sticky notes to the dialog box. If you are installing over a
previous version, all sticky notes will be preserved. Please see “Updating Sticky Notes from a
Previous Version” on page 55 for additional information.

To open the Sticky Notes dialog box:

• Click the Sticky Notes button, or select Sticky Notes from the View menu.
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The left side of the Sticky Notes screen displays all added codes. The right side of the

screen shows the custom notes for the code selected on the left.

Network Version Note: If you have the network version of this application, the Sticky Note dialog box will

contain a Global tab. Click this tab to view global sticky notes added by the
network administrator. To add, edit, or delete a global sticky note you must login

as the administrator by selecting Administrator Login under the File menu.

See “Network Administrator” on page 78 for instructions.

Adding a New Sticky Note  

To add a sticky note for a code selected in the Tabular Listing:

1. Click the Add button, select Insert from the Edit menu, or press Ctrl+I to open the Add

Code dialog box.

This dialog box lists the code and description of the selected code. You choose to add the

code to the bookmarks list, notepad, HCFA-1500 form, and/or create a sticky note for the

code.

2. Click the Sticky Note check box to specify you are adding a sticky note to the selected

code.

3. Click OK to close the Add Code dialog box and open the Sticky Note dialog box.

4. Type your comments in the Sticky Note box. Note that there is a 4,000 character limit for

sticky note text.

5. Click OK to close the dialog box and save your comments. Or, click Cancel to close the

dialog box without saving.

Shortcut

To quickly add a code to the Sticky Notes dialog box without opening the Add Code dialog box:

1. Right-click the desired code in the Tabular Listing.

2. The Add Code shortcut menu will appear. Click Add to Sticky Notes.
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The Sticky Notes dialog box opens and the code you selected and its description are

highlighted.

3. Type your notes in the Sticky Note box and click OK.

Sticky Note Indicator

When a sticky note has been created for a code, you will see a pink flag to the left of the code in

the Tabular Listing.

Viewing or Editing an Existing Note

1. Click the Sticky Note button or select Sticky Notes from the View menu.

2. Use the scroll bar, if necessary, to read through the comments.

3. Click anywhere in the Sticky Note box to add or edit the comments. Or, select the

Expand Edit button which will bring up an Edit Sticky Notes box that allows you to

more easily edit longer notes (limit is 4,000 characters). Edits made to the Edit Sticky

Notes box are automatically saved to the Sticky Note box’s smaller view.

4. Click OK to close the dialog box and save any changes. Or, click Cancel to close the

dialog box without saving.

Deleting an Existing Note

1. Click the code/description from the Sticky Note Dialog to select the sticky note.

2. Click Delete.

Notes: Use the Delete button only to delete the entire sticky note. If you want to delete a block of text

from the Sticky Note box, use the delete key on your keyboard.

Or, use the Expand Edit box from the Sticky Note dialog box to delete or modify the note’s
description.

Updating Sticky Notes from a Previous Version

All sticky notes created in a previous version of Encoder Pro are preserved when you install a

new version, as long as you install the new version in the same directory as the previous version.

As Encoder Pro updates sticky notes from the previous version, it checks to see if there are any

sticky notes assigned to codes that are now invalid (i.e., codes that are deleted under the new

version). If there are any sticky notes assigned to invalid codes, the Sticky Notes Update dialog

box appears when you open the Sticky Notes dialog box.
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From this dialog box you can choose one of two options:

• Delete removes all sticky notes assigned to invalid codes.

• Save keeps all sticky notes assigned to invalid codes. If Save is selected, the invalid

codes will be listed in the Sticky Notes dialog box with the description <Invalid code>.

You can assign the sticky note from an invalid code to a valid code:

1. Use the search feature to look up a valid code that the sticky note should be assigned to.

2. Click the Add button, select Insert from the Edit menu, or press Ctrl+I to open the Add

Code dialog box. This dialog box lists the code and description of the selected code. You

choose to add the code to the bookmarks list, notepad, HCFA-1500 form, and/or create a

sticky note for the code.

3. Click the Sticky Note check box to specify you are adding a sticky note to the selected

code.

4. Click OK to close the Add dialog box and open the Sticky Note dialog box.

5. Select the invalid code and sticky note that you want to assign to the code just added to

the Sticky Note dialog box.

6. Highlight the text of the note in the Sticky Note box and press Ctrl+C to copy it.

7. Click in the Sticky Note box for the valid code and press Ctrl+V to paste the text of the

note from the invalid code.

Once this is done, you can use the Delete button to delete the invalid code from the Sticky Notes

dialog box (see “Deleting an Existing Note” on page 55).

If you continue to list sticky notes for invalid codes, the Update Sticky Notes dialog box will

appear each time you open the Sticky Notes dialog box. If you don’t want the dialog box to

appear, select the “Discontinue showing this dialog” check box.

Copying to the Clipboard
From the Windows clipboard, you can paste codes from Encoder Pro into other Windows

software (e.g., billing program, electronic claim form, etc.). Medicode’s Encoder Pro provides

two ways for copying codes, descriptions, and other information to the clipboard.
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• Ctrl+C or the Copy option under the Edit menu copies the selected code line or block of

text directly to the clipboard.

• The Notepad temporarily stores codes and descriptions before you send them to the

clipboard. Notepad features also let you append modifiers to CPT and HCPCS codes.

Note: Please consult your Windows system documentation for information on using the Windows
Clipboard.

Using the Copy Function

Copying Codes and Descriptions

When you select a code in the Tabular Listing, you use Ctrl+C or the Copy option under the

Edit menu to copy the code and description directly to the Windows clipboard. You can select

only one code at a time because each code is considered a link to the Tabular Listing. You can

decide to copy just the code, to copy the code and full description, or to copy the code and a 48-

character or 35-character description. The shortened description is abbreviated rather than

truncated (Encoder Pro logically abbreviates the description rather than to simply cut it off after

the 35
th

 or 48
th

 character). To set these choices, go to the Edit menu, select Preferences, and

then select the Copy tab.

Copying Text

You can also use the copy function to copy all or a portion of text from these dialog boxes:

• Sticky Notes

• ICD-9 Tabular Notes, CPT Guidelines, and HCPCS Section Notes

• ICD-9 and HCPCS Annotations, and CPT Lay Descriptions

• CPT and HCPCS Modifiers

• HCPCS Special Coverage Instructions
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To copy text:

1. Use your mouse to select the portion of text you want to copy. Click and drag through the

length of the box to select all text.

2. Press Ctrl+C to copy the text to the Windows clipboard.

Note: You can right-click in each dialog box to open a shortcut menu. Use this menu as another way to
select all text in a dialog box and to copy selected data.

Using the Notepad  
You open the Notepad dialog box by selecting the Notepad button or selecting Notepad from

the View menu.

The advantage of using the Notepad is you can perform several searches and then send all the

codes to the Clipboard at one time.

Adding Codes to the Notepad

You can add codes to the Notepad from within the Notepad dialog box or from the Tabular

Listing.

To add a code to the Notepad from within the Notepad dialog box:

1. From the Notepad dialog box’ Contents tab, click Add to insert an empty row.

2. Type the code number and press the Tab key. The description automatically displays.

To add a code to the Notepad from the Tabular Listing:

1. Click the code in the listing to select it.

2. Open the Add Code dialog box, by doing one of these actions: Click the Add button,

select Insert from the Edit menu, or press Ctrl+I.
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The Add Code dialog box lists the code and description of the selected code. You choose

to add the code to the bookmarks list, notepad, HCFA-1500 form, and/or create a sticky

note for the code.

3. Select the Notepad check box to specify you are adding to the Notepad and click OK.

Shortcut

To quickly add a code to the Notepad dialog box without opening the Add Code dialog box:

1. Right-click the desired code in the Tabular Listing.

2. The Add Code shortcut menu will appear. Click Add to Notepad.

The code is automatically added to the Notepad dialog box.

Appending Modifiers

CPT and HCPCS modifiers that are specific to a code selected in the Notepad are available in the

drop-down list in the Modifiers section of the Notepad dialog box (under the Contents tab). You

can append multiple modifiers to a code.

To append a modifier to a code in the Notepad:

1. From the Contents tab, select the code to which you want to append modifiers.

2. Click the drop-down arrow to display a list of applicable modifiers.

3. Select the desired modifier.

4. Click Append to attach the modifier to the selected code. The code appears with the

modifier attached.

5. Click OK to save changes and close the dialog box.

Note: If you want to remove modifier(s) appended to a selected code, select None from the Modifiers

drop-down menu and click Append.
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Duplicating Codes

To duplicate a row in the Notepad:

1. Under the Contents tab, select the row you want to duplicate.

2. Click Duplicate to insert a copy of the row in the Notepad code list.

Deleting Codes

To delete a row from the Notepad:

1. Under the Contents tab, select the row you want to delete.

2. Click Delete to remove the code from the Notepad.

Note: Right-click in the Notepad list to open a shortcut menu. Use this menu as another way to add,
delete, and duplicate codes.

Sending Data to the Clipboard

You can copy just the codes or both the codes and descriptions to the clipboard. To send the

Notepad information to the clipboard:

1. Select the Copy To tab.

2. Specify the Notepad contents to be copied, Codes Only or the Codes and Descriptions.

3. Specify where you want to copy the contents to, the Windows Clipboard and/or a

HCFA-1500 form.

4. If you do not uncheck the Clear Notepad after copying option, all the Notepad contents

will be deleted after you click Copy Now.

5. Click Copy Now.

6. Click OK to close the Notepad.
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Using the HCFA-1500 Form  
You use the electronic HCFA-1500 form to enter claim information for a patient. After you enter

information in the HCFA-1500 form, you can save, export, and/or print the file. This section

explains how to open a new or existing HCFA-1500 form. It also provides instructions on

completing each field of the HCFA-1500 form.

Using the HCFA-1500 form is simple and straightforward because you enter information directly

into a screen that looks like the actual HCFA-1500 form.

Note: Medicare carriers who process the scannable, red ink version of the HCFA-1500 require special
forms that cannot be created through your PC printer. If you attempt to print red-ink versions of
the HCFA-1500 and submit them to a Medicare carrier, your claim may not be accepted. Check
with your Medicare carrier to see if black and white copies of the HCFA-1500 can be submitted.

Opening a New HCFA-1500 Form

To open a new (untitled) HCFA-1500 form, do one of these actions:

• Select New HCFA-1500 under the HCFA-1500 menu.

• Click the HCFA-1500 button.

The HCPCS-1500 window appears similar to the following figure.

Opening an Existing HCFA-1500 Form

To open a form you saved previously:

1. From the HCFA-1500 menu, select Open/Import HCFA-1500. You will see the

Open/Import HCFA-1500 dialog box.

2. Select the appropriate file name and click the Open button. The data will automatically

appear in the HCFA-1500 screen.
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Note: If you want to open a HCFA-1500 form created by an older version of Encoder Pro (version 1.3 or
older), you must first use the HCONVERT.EXE utility. Found on the Encoder Pro CD-ROM, this
utility converts old .hcf files to the proper format for Encoder Pro version 2.4. Instructions for using
the HCONVERT.EXE are found in the HREADME.TXT text file on the Encoder Pro CD-ROM.

Adding a Code Directly to the Line Items

To open a new or previously saved HCFA-1500 form and directly add a code from the Tabular

Listing to the line items section of the form:

1. Select a code from the Tabular Listing.

2. Click the Add button to open the Add Code dialog box.

3. At the Add Code dialog box, mark the HCFA-1500 check box (if it isn’t already marked)

and click OK. A new HCFA-1500 form opens, with the selected code listed in the appropriate

field of the line items section.

Shortcut

To quickly add a code to a new HCFA-1500 form without opening the Add Code dialog box.

1. Right-click the desired code in the Tabular Listing.

2. The Add Code shortcut menu will appear. Click Add to HCFA-1500.

A new HCFA-1500 form opens, with the selected code listed in the appropriate field of the line

items section.

Note: You can add codes from the Tabular Listing directly to a currently open HCFA-1500 form. Click-
and-drag the HCFA-1500 window to the bottom of your screen. Then follow either steps 1–3
above or the shortcut steps. The code is “pasted” into the appropriate field of the line items
section of the HCFA-1500 window that is open.

Completing Fields in the HCFA-1500 Window

Moving to a Field

To enter information in the HCFA-1500 electronic form, you must move the insertion point to

the field or item you want to complete.

• Click in a particular field on the form to move to that field and enter data.

• Press the Tab key to move from one field to the next.

• Press Shift+Tab to move to the previous field.

Note: The Tab and Shift+Tab options are available for all fields except those that have a radio button,
such as item 3b where you must click M or F with the mouse to specify the sex of the patient.
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Entering Data

Most fields are data entry fields; simply move to the appropriate field and enter information with

the keyboard.

Some fields have option buttons. Click an option button to mark or unmark an item.

Using the HCFA Toolbar

When you open a HCFA-1500 form, the Encoder Pro toolbar buttons change. The new buttons

enable you to add codes, save, print, zoom, and close the open HCFA-1500 form.

Add Codes to the Form  

Click the Add button to open the Add Code dialog box. Select HCFA-1500 to add the currently

selected code to the open HCFA-1500 form.

Saving the Form  

To save a completed form for the first time, click the Save button. This will open the Save As

dialog box. Specify where you want to save the file, name the file, and then click Save.

After a HCFA-1500 file has been saved once, click the Save button to save additional changes to

the open HCFA-1500 file.

Note: Add the .txt extension to the file name to save the contents of the HCFA-1500 as an ASCII text file
that can be exported into other Windows applications.

Printing the HCFA-1500 Form  

1. Open the HCFA-1500 form you want to print.

2. Click the Print button from the HCFA-1500 toolbar to open the Print dialog box.

3. Select the print options you want and click OK.
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Note: The Preferences dialog box allows you to specify parameters for printing the HCFA-1500 form. If
you have a color printer, you can choose to print the form in red and the contents in black. Or, you
can choose to print just the contents. This option allows you to insert a blank red ink form in the
printer. See “Setting HCFA-1500 Print Preferences” on page 13.

Zoom

• Click the Zoom button to enlarge the HCFA-1500 form.

• Click the Zoom button again to return form to normal size.

Closing the Form

• Click the Close button to close the open HCFA-1500 form.

Deleting HCFA-1500 Files  

1. Click the Delete button, or from the HCFA-1500 menu, select Delete HCFA-1500. The

Delete HCFA-1500 dialog box will appear.

2. Select the file you want to delete and click the Delete button.

Importing HCFA-1500 Information  

You can import tab delimited ASCII files created in other applications into an Encoder Pro

HCFA-1500 form.

1. Click the Open\Import button, or select Open\Import HCFA-1500 from the

HCFA-1500 menu. The Open\Import dialog box will appear.
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2. Select the ASCII file and click OK to open a new HCFA-1500 form with the imported

data.

To import an ASCII file properly, the file must be Tab delimited and must contain information

pertaining to only one HCFA-1500 record. See the online Help for more information on

importing files.

Understanding the HCFA-1500 Fields

The following describes each field on the HCFA-1500 form.

Health Plan – Item 1. The information in this box identifies the patient’s insurers. You may

need to check more than one box. Correctly complete Item 9 for information regarding other

benefits. Keep each patient’s insurance information up-to-date. With dual coverage becoming

more common, confusion easily arises over which insurer is primary and which is secondary.

Carefully follow your carrier’s guidelines for Medicare Secondary Payer (MSP) situations and

make it someone’s responsibility to verify each patient’s insurance data.

Patient Name – Item 2. The patient’s name and demographic information are extremely

important. Instructions tell you to list the patient’s last name first, then first name and middle

initial. With electronic claims processing, claims listing the first name first may be delayed.

Another important detail is to check your spelling. Simple transposition of letters or misspelled

names can result in denial or suspension of your claim. Also, verify the demographic information

about your patient. The patient’s address may not be the same as the insured’s – a common cause

of delayed payments.

Address – Item 5. List the mailing address. Specify a permanent mailing address. Remember to

include telephone number.

DOB/Sex – Item 3. Enter a four-digit year for date of birth and select the patient’s sex. The

patient’s sex and date of birth are required by most insurance companies. Insurers use the

birthdate as verification of the patient as well as an indication of Medicare eligibility.

Patient Relationship to Insured – Item 6. This box, describing the patient’s relationship to the

insured, verifies eligibility. Remember the patient’s relationship to the insured is not always

‘Self.’
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Patient Status – Item 8. This field indicates the patient’s marital and employment or student

status. This information relates to box 6. If you check spouse as the relationship to the insured

and then mark single under patient status, a good edit system will suspend your claim.

Insured’s ID Number – Item 1a. List the insured’s identification (I.D.) number in this box.

Verify that the I.D. number corresponds to the insured listed in box 4. The patient and the insured

aren’t always the same person.

Insured’s Name – Item 4. As a rule of thumb for Medicare, the patient and insured are the same.

For private payers, some insurers assign a unique number to each enrollee. List the name of the

insured if the patient’s primary insurance is other than Medicare. Enter ‘Same’ when the insured

is the patient. Leave box 4 blank when Medicare is the primary insurance.

Insured’s Address – Item 7. Assuming that the address of the subscriber and your patient are

the same may cost you time and result in an unpaid claim. Supplying all information, including

phone numbers with area codes, may avoid delays when an insurance company must contact the

insured for additional information. Enter ‘Same’ in box 7 when the insured is the patient.

Policy, Group, or FECA Number / Employer or School Name / Insurance Plan or Program

Name – Item 11a-11c. Use these fields to expand on the insured’s information. Beginning with

the policy or group number, you must also list the insured’s birthdate, sex, and employer’s name

or school name. Data from these fields help the payer determine primary and secondary coverage.

For Medicare claims, enter ‘None’ and do not complete boxes 11a-11c if no insurance is primary

to Medicare.

Another Health Benefit Plan – Item 11d. Check Yes if there is information regarding other

benefits. For example, a patient, who has Medicare as primary payer and AARP as secondary, or

other may be the patient’s spouse who is insured through an employer. This information assists

in coordinating benefits and determining liability. For Medicare claims, leave box 9 blank if no

Medigap benefits are assigned, and enter information only if requested by the beneficiary.

Beneficiaries are responsible for filing a supplemental claim if the private insurer does not

contract with Medicare for electronic remittance of claim information.

Other Insured’s Name / Policy or Group Number / Date of Birth / Sex / Employer or School

Name / Insurance Plan or Program Name – Item 9a-9d. List the name of the insured of the

patient’s secondary insurance. Use these fields to expand on the insured’s information. Beginning

with the policy or group number, you must also list the insured’s birth date (as a four-digit year),

sex, and employer’s name or school name.

Reserved for Local Use – Item 10d. Enter information that may be necessary for your local

carrier, such as the patient’s Medicaid number preceded by MCD.
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Patient’s Condition – Item 10. This multiple choice field determines whether the patient’s

condition is related to employment or an accident. Note that auto accident has its own line and a

field exists for the state in which the accident occurred. Use the two-letter U.S. Postal Service

abbreviations. Item 10 is important to the payer because it indicates liability. Incorrectly checking

this box will cause your claim to be suspended or denied.

Signature and Date –Item 12. Use this field to indicate that a signature is on file. Enter a date if

appropriate.

Signature –Item 13. Use this field to indicate that a signature is on file. A date may also be

necessary.

Date of Current Condition  / Date of First Occurrence – Items 14, 15. This information

defines the patient’s medical problem and provides information for treatment provided. Most

insurance companies require information on the patient’s illness, such as when the symptoms

first appeared and if the patient has had the same or similar problems. Medicare does not require

that box 15 be completed.

Dates Patient Unable to Work – Item 16. This field indicates the days a patient may be unable

to work in his or her current occupation. While these dates may be unimportant to Medicare and

private payers, they are very important to a workers compensation claim. Your state workers

compensation carrier may require additional forms explaining when the patient can return to

work or forms providing disability information. Become familiar with these forms when treating

an employment-related injury or disease.

Name of Referring Physician / ID Number – Items 17, 17a. Medicare requires the referring

physician’s (or other sources) name and National Provider Identifier (NPI). Several Medicaid

agencies also require this information, using the provider’s medical license number instead of the

Medicare NPI.

Hospitalization Dates – Item 18. The dates of admission and discharge are necessary for

hospital care. Enter a four-digit year for the dates. The dates you list must match the hospital’s

dates because payers often use these records to verify billed services

Reserved for Local Use –Item 19. Use this field to enter additional information, including:

• Eight-digit date the patient was last seen and the National Provider ID (NPI) of the

patient’s attending physician for physical and occupational therapists.

• Eight-digit x-ray date for chiropractic services.

• Drug name and dosage when submitting a claim for not otherwise classified drugs.

• A clear description of “unlisted procedure codes.”

• Applicable modifiers when -99 is listed in the line items window.

• The statement “Homebound” when a homebound/institutionalized patient has an EKG

tracing or specimen obtained from an independent lab.
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Outside Lab; Charges – Item 20. Complete box 20 when billing diagnostic tests subject to

purchase price limitations. Enter ‘No’ if no purchased tests are indicated on the claim. Enter

‘Yes’ and complete box 32 if the diagnostic test was performed outside of the entity billing for

the service.

Diagnosis or Nature of Illness or Injury – Item 21. This listing has four slots for diagnostic

codes, numbered 1 through 4.

Medicaid Resubmission – Item 22. Medicaid requests a resubmission code and the original

reference number.

Prior Authorization # – Item 23. List the prior authorization number in this field. It is required

by Medicare, Medicaid, and many managed care organizations.

Line Items – Item 24. This box contains the lines of service. A description of fields in the Line

Item Editor window is shown below. The column references indicate the columns of Item 24 on

the HCFA-1500 form. If you expect to be paid, be sure to complete these fields accurately,

including date(s) of service, place of service, procedure codes and modifiers, charges, days/units,

and type of service.

DOS – Column G. List the actual date of service, not the date you file the claim. If you

provided services several times within a calendar month, list the beginning and ending dates,

and place the number of days of service in column G.

POS – Column B. CPT’s Evaluation and Management (E/M) codes are keyed to place of

service (POS), so column B has become even more important. Past HCFA-1500 forms listed

HCFA’s standard POS codes on the back, but they’ve been deleted from the current form. A

POS code was added, 50 Federally Qualified Health Center, defined as, a facility located in a

medically underserved area that provides Medicare beneficiaries preventive primary medical

care under the general direction of a physician. Because these codes are required by

government payers, we’ve included them here for you; but you’ll need to check with private

insurers as to how they want place of service indicated. See Place of Service Codes at the end

of this section for a list of POS descriptions.

TOS – Column C Type of service (TOS) codes also appeared on the back of the previous

form, but have been deleted from the current one. Even though this field remains on the form

(column C), not all government and private payers require this information.

CPT/HCPCS – Column D. This field is the place for procedure codes (CPT and HCPCS). As

with diagnostic information, the procedure description field has been eliminated. A thorough

understanding of CPT and HCPCS coding is a must to fill in these columns.

Modifier – Column D Enter a CPT or HCPCS modifier, if appropriate, to be appended to the

CPT or HCPCS code. If adding multiple modifiers, use hyphens to separate the modifiers

(e.g., “-50 -21”).
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Diagnosis – Column E. To establish medical necessity for the services provided, use column

E to reference the appropriate diagnoses from box 21 to each procedure. List the diagnoses by

item numbers 1, 2, 3, or 4 rather than by ICD-9 code. If listing multiple diagnosis numbers,

use commas to separate the numbers (e.g., “1, 4”).

Charges – Column F. Obviously, the charges in column F are important since you’re telling

the payer how much you want to be paid. Each service or line item should have a separate fee

with the total charges noted in box 28. Unless there are unusual circumstances surrounding

the service (e.g., additional time and effort) or if the service is reduced, the fees you charge

should be consistent on a code-by-code basis. Exceptions are noted by adding a modifier to

the affected procedure code.

Days or Units – Column G. List days or units in column G. This information is essential for

payment of multiple days in the hospital or multiple units of the same code, such as drugs.

Enter the elapsed time in minutes for anesthesia procedures.

EPSDT – Column H This field indicates Early Periodic Screening and Developmental

Testing (EPSDT) and family planning.

EMG – Column I This field identifies treatment provided in an emergency department.

Remember that emergency services must also be indicated with the appropriate place of

service code in column B. Medicare no longer requires this field.

COB – Column J. This field is used for coordination of benefits.

Local Use – Column K. Any special use for column K is determined by individual payers. For

Medicare claims, enter the carrier-assigned provider identification number (PIN) when the

performing physician/supplier belongs to a group practice. When more than one

physician/supplier within a group bills on the same form, enter the individual PIN for the

corresponding line items.

Place Of Service Codes

11 Office

12 Patient’s home

21 Inpatient hospital

22 Outpatient hospital

23 Emergency room - hospital

24 Ambulatory surgical center

25 Birthing center

26 Military treatment facility

31 Skilled nursing facility

32 Nursing facility

33 Custodial care facility

34 Hospice

41 Ambulance - land
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42 Ambulance - air or water

50 Federally Qualified Health Center

51 Inpatient psychiatric facility

52 Psychiatric facility - partial hospitalization

53 Community mental health center

54 Intermediate care facility - mentally retarded

55 Residential substance abuse treatment facility

56 Psychiatric residential treatment center

60 Mass immunization center

61 Comprehensive inpatient rehabilitation facility

62 Comprehensive outpatient rehabilitation facility

65 End stage renal disease treatment facility

71 State or local public health clinic

72 Rural health clinic

81 Independent laboratory

99 Other unlisted facility

Federal Tax ID – Item 25. Place your federal tax I.D. number in this field. Indicate whether this

is your Social Security number or an employer identification number. Use either your employer

or tax I.D. number consistently to avoid confusion on the 1099 forms you receive from third-

party payers. Always verify the tax I.D. numbers on your 1099 forms because an error in

unreported income may trigger an IRS audit.

Patient’s Account # – Item 26. The patient account number field is purely for your convenience.

Many payers list your patient’s account number on the explanation of benefits which saves you

the time it takes to research which “Mrs. Jones’s” account should be credited with this payment.

Accept Assignment – Item 27. The assignment box generally applies to government claims but

may apply to other payers with whom you have a contractual agreement. If your office

participates with Medicare, this box must always be checked yes. Nonparticipating physicians

may decide on a claim-by-claim basis whether to accept assignment and check yes or no.

Medicare assumes the claim is unassigned if this box is left blank and sends the check to the

patient. If a participating physician leaves this blank, it could be viewed as a violation of the

participation agreement with Medicare.

Facility Where Services Rendered – Item 32. Enter the name and address of the facility if the

services were furnished in a hospital, clinic, laboratory, or facility other than the patient’s home

or physician’s office. When the name and address of the facility where the services were

furnished are the same as the biller’s name and address shown in item 33, enter the word ‘same.’

Providers of services (namely physicians) must identify the supplier’s name, address, and NPI

when billing for purchased diagnostic tests. When more than one supplier is used, a separate

HCFA-1500 should be used to bill for each supplier. This item is completed whether the supplier

performs the work at the physician’s office or at another location.
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If a -QB or -QU modifier is billed, indicating the service was rendered in a Health Professional

Shortage Area (HPSA), the physical location where the service was rendered must be entered if

other than home. However, if the address shown in item 33 is in a HPSA and is the same as

where the services were rendered, enter the word ‘SAME.’ If the supplier is a certified

mammography screening center, enter the 6-digit FDA approved certification number.

Physician or Supplier Billing Name/Address – Item 33. The information in this box further

identifies your practice to the insurer. Enter the appropriate, payer-specific provider number as

well as your group name, address, and phone number. For Medicare claims, enter the carrier-

assigned PIN, not NPI, for a performing physician/supplier who is not a member of a group

practice. Enter the group number for a performing physician/supplier who is a member of a group

practice.

Tips for Submitting Clean Claims

Claims submitted with all of the information necessary for processing are referred to as ‘clean’

and are usually paid in a timely manner. Paying careful attention to what should appear on your

claim form helps produce these clean claims. Now we’ll discuss some of the common reasons

that claims are denied. Being aware of common mistakes helps you avoid them. It’s extremely

important to read the communications you receive from insurers. Their information will often put

you on the right track to correct your errors through resubmission.

Common Errors in Claims Submission

• The patient’s I.D. number is incorrect.

• The patient’s name and address don’t match the insurer’s records.

• The physician’s tax I.D. number, provider number, NPI, or Social Security number is

missing.

• There is little or no information regarding primary or secondary coverage.

• The physician’s or authorized person’s signature is missing.

• Dates of service are incorrect or don’t relate to the claims information from other

providers (hospital, nursing homes, etc.).

• The fee column is blank or not itemized and totaled.

• The patient information is incomplete.

• The CPT and/or ICD-9 codes are invalid, or the diagnostic codes aren’t linked to the

correct services or procedures.

• The claim is illegible.
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Printing
Medicode’s Encoder Pro lets you print general information, such as tabular results, tabular listing

(codes and descriptions), the bookmarks list, and notepad contents, as well as an open

HCFA-1500 form. You can also print information in any code-specific dialog box, based on the

code you have selected.

1. Click the Print button or select Print from the File menu. The Print Report dialog box

appears, similar to the following figure.

2. Select the item(s) you want to print. (For a description of each print item see the

following pages.)

3. Click the Setup button to display the Print Setup dialog box.

You can also access this dialog box by selecting Print Setup from the File menu.

Use the Print Setup dialog box to identify the type of printer you use, specify the paper

tray, and set up other print preferences.

4. Click Print.

Note: To print a HCFA-1500 form, you must first open the form and then select print.

Print Report Options

General Reports

• Tabular Listing. For CPT and HCPCS codes, prints the current screen view in the

Tabular Listing. For ICD-9 codes, prints all fourth- and fifth-digit codes,

excludes/includes, modifiers, and other tabular information for the currently selected

3-digit category.
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• Search Results. Prints codes and descriptions of all results for the current search. Number

of lines printed is based on the number of total results, not the number of codes and

descriptions in the screen view.

• Index Results. Prints codes and descriptions in each tab of the Index Results for the

current search.

• Bookmarks. Prints all bookmarks.

• Sticky Note. Prints all sticky notes.

• Notepad. Prints contents of the Notepad dialog box.

Code Specific Reports

• Guidelines, Notes, References. Prints AMA guidelines, parenthetical commentary, and

AMA CPT Assistant references for the currently selected CPT code; section notes for the

currently selected HCPCS code; and ICD-9 tabular notes and AHA Coding Clinic

references for the currently selected ICD-9 code.

• Annotations or Lay Descriptions. Prints annotations for the currently selected ICD-9 or

HCPCS code, and lay descriptions for the currently selected CPT code.

• Modifiers. Prints range-specific modifiers for the currently selected CPT code and code-

specific modifiers for the currently selected HCPCS code.

• Unbundled Codes. Prints two lists of unbundled codes for the currently selected CPT

code: CCI component code unbundles and mutually exclusive code unbundles.

• Surgical Crosscodes. Prints ICD-9, HCPCS, ADA, and Anesthesia codes, as applicable,

crossed to the currently selected CPT code. Or, prints CPT codes crossed to the currently

selected ICD-9 Volume 3 (procedural) code.

• Medicare Information. Prints Medicare Relative Values, Global Information, and

Medicare Rules for the selected CPT code. Or, prints CIM/MCM references for the

currently selected HCPCS code.

• DRG Crosscodes. Prints the DRG code and description, MDC, medical/surgical

designation, and Medicare calculation information (GMLOS, AMLOS, RW, etc.) for the

currently selected ICD-9 code.

• Sticky Note. Prints the selected sticky note.

Using the E/M Encoder
If you are searching for a CPT evaluation and management (E/M) code that is based on key

components, the E/M Encoder wizard can be a useful tool for finding the correct code. The E/M

Encoder helps you make sense of confusing CPT concepts like levels of service and key

components. Through the E/M Encoder, you identify place of service, type of service, and other

relevant aspects of the E/M service. The E/M Encoder determines which code(s) are appropriate.
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Opening the E/M Encoder

The E/M Encoder automatically opens when you enter a search term (e.g., “visit” or

“consultation”) that describes an E/M service that is reported by a CPT code with a key

component. You can also access it by selecting E/M Encoder from the File menu.

To enter the E/M Encoder, click Next. The E/M Encoder displays a series of menu selections

based on the criteria you select. To cancel out of the E/M Encoder, click Cancel. The software

conducts a regular search of the index.

Make selections from the drop-down lists that appear in each window and click Next to move to

the next menu of selections. Click Back to change a previous selection.

Understanding the E/M Encoder Dialog Boxes and Menus

This section explains the components of the main E/M Encoder dialog boxes and menus. Keep in

mind that not all the dialog boxes/menus discussed below appear every time you use the E/M

Encoder, nor are all dialog boxes or menu options discussed here. For detailed explanations of

evaluation and management terms, please consult the introduction to the E/M codes in CPT

2001.

Place of Service

Use this dialog box to specify where the service took place. The two main location types are (1)

office and other outpatient or ambulatory facilities, and (2) hospital and other inpatient locations.

You can select only one place of service type.
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Here are CPT guidelines that can help you determine which menu selections are appropriate (not

all menu selections are referenced here):

• Select an outpatient facility unless the patient has been admitted as an inpatient to a

healthcare facility.

• Select observation if the patient is designated/admitted as “observation status” in a

hospital. The patient does not need to be located in an observation area designated by the

hospital.

• CPT defines an emergency department as “an organized hospital-based facility for the

provision of unscheduled episodic services to patients who present for immediate medical

attention. The facility must be available 24 hours a day.”

• Select home for services provided in a private residence.

• Select inpatient hospital for patients admitted as inpatients in a hospital or “partial

hospital” setting.

• Select nursing facility for care provided in a skilled nursing facility (SNF), intermediate

care facility (ICF), long term care facility (LTCF), or psychiatric residential treatment

center.

• Select domiciliary facility, rest home or custodial facility for the place of service that

provides long-term room, board, and other personal assistance services.

Type of Service

Use this dialog box to specify the type of service provided. The selections available are based on

whether the place of service is in an outpatient or inpatient setting (i.e., are determined by your

selections from the Place of Service menu). This dialog box is also used to specify whether the

patient is new or established (patient status), whether the counseling and/or coordination of care

dominated the patient and/or family encounter, and (for inpatient settings) whether the type of

care was an initial visit or subsequent/follow-up visit.

Outpatient Setting options Inpatient Setting options
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Here are CPT guidelines that can help you determine which menu selections are appropriate (not

all menu selections are referenced here) for type of service:

• Select attendance for encounters by the physician in an inpatient setting. Examples of

attendance include hospital admission, examination, and initiation of treatment;

comprehensive nursing facility assessments; scheduled follow-up visits.

• Select consultation for services provided by a physician whose opinion is requested by

another physician or other appropriate source, including the patient or the patient's family.

• Select observation for patient designated as “observation status.”

Here are CPT guidelines that can help you determine patient status:

• According to CPT, a new patient “has not received any professional services from the

physician or another physician of the same specialty who belongs to the same group

practice, within the past three years.”

• If the physician is on call or covering for another physician, the patient status is based on

the relationship with the physician who is not available.

Here are CPT guidelines that can help you determine which menu selections are appropriate (not

all menu selections are referenced here) for type of care in an inpatient setting:

• Select initial type of care for services that are the first inpatient encounters with the

patient by the admitting physician.

• If the patient is admitted to the hospital as an inpatient from another site of service (e.g.,

emergency department, physician's office, etc.), all E/M services “provided by that

physician in conjunction with that admission are considered part of the initial hospital

care when performed on the same date as the admission,” according to CPT.

• Select subsequent type of care for services that include review of the medical record and

diagnostic study results, and changes in the patient's status since the last assessment by

the physician.

Here are CPT guidelines that can help you determine counseling and/or coordination care time:

• Counseling and/or coordination of care includes the “face-to-face time in the office or

other outpatient setting or floor/unit time in the hospital or nursing facility.”

• Select “More than 50% of encounter” if the counseling and/or coordination of care

dominates the physician/patient and/or family encounter. According to CPT, the “extent

of counseling and/or coordination of care must be documented in the medical record.”

Here are CPT guidelines that can help you determine which menu selections are appropriate for

type of consultation:

• Select initial to identify a new consultation. According to CPT, “Follow-up visits in the

consultant's office or other outpatient facility that are initiated by the physician

consultant” should be identified as an office visit rather than a consultation. In this case,

click Back to reselect the type of service.



E N C O D E R  P R O  U S E R ’ S M A N U A L 77

VERSION 2.4

• For inpatients, “only one initial consultation should be reported by a consultant per

admission.”

• Select follow-up if the service is a completion of the initial consultation or if subsequent

consultative visits are requested by the attending physician.

• Follow-up consultation codes are not appropriate if, subsequent to the completion of a

consultation, the consulting physician “assumes responsibility for management of a

portion or all of the patient's conditions,” according to CPT. Click Back to reselect the

type of service as attendance or visit.

• Select confirmatory for a consultation requested by a patient and/or family member.

• Report modifier -32 if a confirmatory consultation is required by a third-party payer.

Key Components

Use this dialog box to specify the levels of the E/M service based on the history, examination,

and medical decision making.

• The first two sections (drop-down lists) focus on the history of the present condition and

are used to identify whether the history is brief or extended, includes a system review,

and/or includes the patient's past, family, and social history.

• The next two sections identify the focus and type of the examination.

• The last three sections identify the complexity of the medical decision making.

For a detailed explanation of the terminology used in history, examination, and medical decision

making, plus an explanation of the E/M levels of service and key components, see the

introduction to the E/M codes in CPT 2001.
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Network Administrator
The network version of Encoder Pro allows a system administrator to specify global sticky notes

and bookmarks, which can be accessed by all network users. When you log in as the system

administrator, you can specify whether a sticky note and/or bookmark is assigned personally or

globally (for all users on the network). Only the system administrator can add global sticky notes

and bookmarks, but all users can view them.

The administrator can also specify under the Network tab of the Preferences dialog box which

features of the software users can access. To enable the system administrator privileges, you must

log in:

1. Select Administrator Login from the File menu to open the Administrator Login

dialog box.

2. Type the Administrator password and click Login. The initial password when you first

open this dialog box is MEDICODE.

Changing the Administrator Login

1. At the Administrator Login dialog box, click Change to open the Change Password

dialog box.

2. Enter the current password at the Old Password field. The first time you open this dialog

box, enter MEDICODE in this field.

3. Enter your new password in the New Password and Verify Password fields and press

OK.
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Preferences Dialog Box Network Tab

If you are logged on as Administrator, a Network tab will be available in the Edit menu’s

Preferences dialog box. This tab gives the Administrator the ability to activate or inactivate the

following functions for ALL users: HCFA-1500, Personal Sticky Notes, Personal Bookmarks,

Section Notes, Annotations, Modifiers, Unbundle Edits, Crosscodes, Medicare Information, and

DRG Crosscodes. Click the checkbox for any feature to deselect it; click again to reselect it.

In addition, the Network tab has a Set Idle Time Shutdown dropdown list that allows the

Network Administrator to specify how long Encoder Pro can remain idle before the application

shuts itself down.

Menus and Buttons
This section highlights the options available from the menu and button bar. It is arranged

according to options listed under the menu bar; where a button shares the same action, the button

is shown.

File
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Print (Ctrl+P)  

Opens the Print dialog box, which lets you print tabular results and information from dialog

boxes. Check boxes are dimmed if a dialog box is not available for the currently selected code.

Each print item is described below.

Page Setup…

Opens the standard Windows Page Setup dialog box.

E/M Encoder (Ctrl+E)

Opens the Evaluation and Management (E/M) Encoder If you are searching for a CPT evaluation

and management (E/M) code that is based on key components, the E/M Encoder will help you

find the appropriate code.

Administrator Login

Available only for network versions. Opens the Administrator Login dialog box that allows a

user login rights to add global bookmarks and sticky notes. The default login password is

MEDICODE.

Exit (Ctrl+Q)

Closes the application.

Edit

Copy (Ctrl+C)

Copies the selected (highlighted) code or block of text to the Windows clipboard.

Insert (Ctrl+I)  

Opens the Add Code dialog box. This dialog box lists the code and description of the selected

code. You choose to add the code to the bookmarks list, notepad, HCFA-1500 form, and/or

create a sticky note for the code.

Preferences

Opens the Preferences dialog box. In the Search tab you can limit searches to one code set (e.g.,

CPT codes) or a group of code sets, and specify the search type, “match on all terms” or “match

on any term.” You can also include or exclude the Index search.

In the Copy tab of this dialog box, you decide to copy just the code, to copy the code and full

description, or to copy the code and a 48-character or 35-character description..
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In the View tab of this dialog box you specify how you want search results sorted, by weighted

ranking, or in alphanumeric order.

In the Network tab, the administrator can specify which features of the software users can

access.

In the HCFA-1500 tab, you select whether you want to print the HCFA-1500 form in red, with

the contents in black, or print the contents only.

View

Index Results (Ctrl+R)

Opens the Index Results dialog box. This window contains the index results that match your

search criteria.

Bookmarks

Opens the Bookmarks dialog box. This dialog box contains no codes when you first install the

application.

Sticky Note  

Opens the Sticky Note dialog box. This dialog box contains no notes when you first install the

application.

Notepad

Opens the Notepad dialog box. This dialog box contains no codes when you first start up the

application.

Deleted Codes

This dialog box allows you to view all codes that have been deleted.

CPT Color Codes

This dialog box allows you to look up CPT codes according to color codes.
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ICD-9 Color Codes

This dialog box allows you to look up ICD-9 codes according to color codes.

HCPCS Color Codes

This dialog box allows you to look up HCPCS codes according to color codes.

ICD-9

This menu is available only when an ICD-9 code is selected. Information is specific to the

currently selected code. Items not available are dimmed.

Tabular Notes

Opens a dialog box that displays section notes and AHA Coding Clinic references for the

selected code. The section notes include excludes/includes, fifth-digit information, and other

information affecting the selected ICD-9 code.

Annotations  

Opens a dialog box that displays a description and/or explanation of the specific disease or

condition.

CPT (Surgical) Crosscodes

Opens a dialog box that displays CPT crosscodes for Volume 3 (procedural) codes.

This dialog box contains bold magenta code number links that jump you to the appropriate code

in the Tabular Listing. You can access the links by double-clicking or by clicking and then

pressing the Select button.

DRG Crosscodes  

Opens a dialog box that displays DRGs that the selected ICD-9 code is linked to. Diagnostic

Related Groups are used for hospital reimbursement. You see the components (GMLOS,

AMLOS, etc.) that are used to calculate Medicare reimbursement.
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Color Coding Legend

Opens a dialog box that displays the key that explains Medicode’s color coding symbols for

ICD-9 codes, depending on the code selected. These symbols flag codes that require additional

digits, are nonspecific codes, and other important information.

Previous Codes/Next Codes  

Displays the previous/next 2- or 3-digit category in the Tabular Listing.

CPT

This menu is available only when a CPT code is selected.

CPT Guidelines

Opens a dialog box that displays relevant AMA guidelines, parenthetical comments from CPT,

Primary Pxs, and AMA CPT Assistant references for the selected CPT code.

Lay Descriptions  

Opens a dialog box that displays an explanation of the surgical procedures or medical service.

Modifiers  

Opens a dialog box that displays range-specific modifiers for the currently selected CPT code.

Unbundled Codes

Opens a dialog box that displays CPT codes that should not be billed with the selected CPT code.

You view Medicare’s CCI component code and mutually exclusive unbundles.

Surgical Crosscodes  

Opens a dialog box that displays surgical crosscodes for the selected CPT code. Crosscodes

include relevant ICD-9 Volume 1 (diagnosis), ICD-9 Volume 3 (procedural), HCPCS, ADA

codes, and Anesthesia codes.

Medicare Information  

Opens a dialog box that displays Medicare information for the selected CPT code.
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Color Coding Legend

Opens a dialog box that displays the key that explains Medicode’s color coding symbols for CPT

codes. These symbols flag codes that are starred procedures, add-on (subsidiary) codes, add-on

codes that have a diagnosis that is different than that of the corresponding principal procedure

code, codes for which modifier -51 is exempt, new and revised codes, and nonspecific (unlisted)

codes.

Previous Codes/Next Codes  

Displays the previous/next section of codes in the Tabular Listing.

HCPCS

This menu is available only when a HCPCS code is selected.

HCPCS Section Notes  

Opens dialog box that displays HCPCS section notes for the selected HCPCS code.

Annotations  

Opens a dialog box that displays an explanation of the medical and surgical supply, durable

medical equipment, drug, or professional service.

Modifiers  

Opens a dialog box that displays code-specific modifiers for the currently selected HCPCS code.

Unbundled Codes

Opens a dialog box that displays CPT codes that should not be billed with the selected HCPCS

code, based on Medicare’s CCI component code and mutually exclusive unbundles. This option

only applies to a few HCPCS codes.

Coverage Instructions  

Opens a dialog box that displays special coverage instructions from the Coverage Issues Manual

and Medicare Carriers Manual.
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Color Coding Legend

Opens a dialog box that displays the key that explains Medicode’s color coding symbols for

HCPCS codes, depending on the code selected. These symbols flag codes that have special

Medicare coverage instructions.

Previous Codes/Next Codes  

Displays the previous/next section of codes in the Tabular Listing.

HCFA-1500

New HCFA-1500 (Ctrl+N)  

Opens a new HCFA-1500 dialog box.

Open\Import HCFA-1500 (Ctrl+O)

Opens a dialog box where you select a HCFA-1500 file that has already been saved, or import

ASCII files created in other applications. This item is not available if no HCFA-1500 files have

been saved.

Delete HCFA-1500 (Ctrl+D)

When a HCFA-1500 form is open, this will open the Delete HCFA-1500 dialog box where you

delete HCFA-1500 files.

Save (Ctrl+S)

Saves changes to the currently open HCFA-1500 file.

Save As/Export (Ctrl+A)

Opens a dialog box where you name and save the open HCFA-1500 form. Add the .txt extension

to the file name to save the HCFA-1500 contents as an ASCII text file that can be exported into

other Windows applications.

Zoom

Magnifies the screen view of the currently open HCFA-1500 window. Select again to return to

the normal view.
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Close HCFA-1500 (Ctrl+L)

Closes the open HCFA-1500 dialog box.

History

This menu displays a list of codes that you have selected during the current lookup session. The

code trail shows up to 15 of the latest code selections, with the most recent at the top. Use the

trail to go back to codes you’ve already searched.

Help

Coding

Provides guidelines, definitions, and tips for coding with ICD-9, CPT, and HCPCS codes and

modifiers.

Application Help (Ctrl+H)

Provides instructions on using Medicode’s Encoder Pro.

About…

Opens a splash screen that lists copyright and version information.


